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1. Introduction 
The AxTrax™ AS-525 Access Control System is a complete 
software management system for use with AC-215, AC-225, 
AC-225IP, and AC-525 Access control panels. 
The AxTrax AS-525 Access Control System is user-friendly, 
intuitive, and rich in functionality. The system can manage up 
to 30,000 users, and offers complete control over up to 4,092 
doors (with the MD-D02 reader expansion board). Using AxTrax 
AS-525, you can configure doors by area and time, for different 
types of personnel and for varying alarm situations. 
The AxTrax AS-525 Access Control System is capable of 
integrating with Video Surveillance software AS-525AV ViTrax. 
The main purpose of the integration is to enable video 
recording based on access control events, and convenient 
playback. 
This manual is compatible with AxTrax AS-525 software 
Version 00.04.07 and ViTrax Version 1.7.5 and later. 

1.1 System Features 
AxTrax AS-525 makes it possible to control and monitor every 
aspect of access control on a site. The system includes a built-
in software security system that controls access to the system 
database, and logs all performed operations. In addition, the 
system boasts the following Professional Grade features: 
• A free basic level-0 server software license for up to 64 

panels (ACUs). Three incremental license levels can be 
activated by buying a Rosslare HASP key (the CD-ROM is 
provided with the package). 

• User-friendly PC software with intuitive layout reduces the 
complexity of access control. 

• Manages user data, photo and information fields, access 
rights, alarms, strike time, and door mode, all from one 
central location. 

• Produces reports from acquired data, such as entry &exit 
times, as well as alarm types initiated by user, location, and 
time events. 

• Available in a large variety of languages. 
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• Compatible with additional software modules from 
Rosslare, for time, attendance, and photo ID card 
development. 

• Backward compatibility with VeriTrax AS-215 and AS-225. 
 

1.1.1. Access Control 

Access groups define access rights for every part of the site. 
Access rights are time dependent; for example, users in the 
"Mornings Only" access group can have access to certain 
areas of the site between 9 am and 12 pm only. 
Each user is assigned to an access group. The system also 
stores an identification photograph and personal details for 
each user, as well as user specific access settings, such as 
Antipassback immunity, requirements for an extended open 
door period, configurable special privileges, and triggered 
outputs. 
 

1.1.2. Access Monitoring 

AxTrax AS-525 records every attempt to open a door within the 
site. Status maps show the state of every part of a facility, while 
an Events log records complete details of every time access is 
granted or denied for every door on a site, while also 
monitoring possible door tampering and forced entries. 
AxTrax AS-525 can also produce a variety of access reports, 
including usage reports, attendance records, and roll calls. 
Using the AxTrax Report Wizard, users can design their custom 
reports to meet their specific needs. 
 

1.1.3. Software Security 

Access to the AxTrax AS-525 software is password controlled. It 
is possible to grant to different operators restricted security 
rights, with access to only specified elements of the system or 
with read-only access.  
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1.2 AxTrax Server and Client 
The AxTrax AS-525 system includes both the AxTrax AS-525 
Server and the AxTrax AS-525 Client software. 
AxTrax AS-525 Server should be installed on the computer that 
will control the access control panels and manage the 
database. It includes a full suite of administrator functions, 
including the ability to change panel network parameters, 
download new firmware to individual access control panels, 
and manage the AxTrax AS-525 database.  
Additional computers can use the AxTrax AS-525 Client 
software, which connects to the panel network through the 
AxTrax AS-525 Server. The AxTrax Client has a limited operation 
set, and can only send or receive information from access 
control panels when the AxTrax Server is operating and 
connected to the panel network. 
One AxTrax AS-525 Server can serve an unlimited number of 
AxTrax AS-525 Clients. 
 

1.3 Using this User Guide 
This user guide provides all the information required to start 
working with AxTrax AS-525. Refer to the AC-215, AC-225, or 
AC-525 hardware manuals for wiring and installation 
instructions. 
• How to install AxTrax AS-525 on a computer 
• The basic functionality of AxTrax AS-525 
• How to set-up AxTrax AS-525 for a new site 
• How to monitor and manage a site using AxTrax AS-525 
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2. Specifications and Requirements 

2.1 System Capabilities 

General 
Software Architecture Client-Server 
Database Type SQL Server Express 2005 
Max. Number of Users 30,000 
Max. Access Groups 30,000 
Max. Number of Time Zones 32 
Max. Cards per User 16 
Max. Number of Doors  4092 
Max. Access Control Panels  1023 
Max. Number of Departments 1023 
Antipassback • Timed 

• Door 
• Global - using Access Areas 

International Holiday Support 64  
 

Networks 
Max. Number of Networks 1023 

Supported Access Control 
Panel Models 

• AC-215 
• AC-215 (SPV) 
• AC-225 
• AC-225 with MD-IO84  
• AC-225 with MD-D02  
• AC-525 
• AC-525 with MD-IO84  
• AC-525 with MD-D02  

Panel Networks 
Communication Interface 

• Serial (RS-232) 
• TCP-IP 
• Modem  

Communication Speed 9600, 19200, 57600, and 
115200 bps 
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2.2 System Requirements 

2.2.1. AxTrax AS-525 System Minimum Requirements 

Operating System Windows XP SP2, Windows Vista, or 
Windows 7 

Processor Pentium 4 or better 
Memory 256 MB (512 MB recommended) 
Network LAN card required for TCP/IP 

networking 
Hard Disk Space 1.5 GB (500 MB free space) 

 

2.2.2. SQL Express Server Minimum Requirements 

Operating System Windows XP SP2, Window Server 
2003, Windows Vista, or Windows 7 

Processor Pentium 4 or better 
Memory 256 MB (512 MB recommended) 
Hard Disk Space 600 MB (256 MB free space) 

(SQL Express is not always required. See Choosing an SQL Server, on page 10.) 
 

2.2.3. HASP USB Key Requirements 

1–64 Active Panels HASP key not required 
65–256 Active Panels Level 1 HASP key required 
257–512 Active Panels Level 2 HASP key required 
513–1023 Active Panels Level 3 HASP key required 
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3. Installation 
The AxTrax AS-525 installation CD-ROM includes all the setup 
files required to run the AxTrax Server or Client on a computer. 
The installer includes the following elements: 
• Microsoft® SQL Server Express 2005 
• Microsoft® .NET 2.0 Framework 
• AxTrax AS-525 Access Control management System (Server 

and / or Client) 
• HASP key driver (AxTrax Server only) 

 

Note: 
SQL Server Express and the Microsoft® .NET 
Framework are pre-requisite software and are not 
installed unless required. 

3.1 Choosing an SQL Server 
The AxTrax Server operates using an SQL database. If there is 
already an SQL server available on your computer network, 
use it to run the AxTrax database. 
Alternatively, install the Microsoft SQL Server Express on the 
computer that you will be using as the AxTrax server. 

 

Note: 
Do not install the SQL server for AxTrax Client 
installations. AxTrax Clients connect to the AxTrax 
Server database. 

3.2 Starting the AxTrax Installer 
Install the AxTrax AS-525 Access Control System using the 
installation CD-ROM. 

To begin installing AxTrax AS-525: 
1. Insert the CD into your computer's CD drive.  
2. Open My Computer, double-click the CD drive icon, and 

then double-click the AxTrax AS-525 setup file. 
If the setup detects a previous version of AxTrax AS-525, a 
prompt appears asking if you want to upgrade AxTrax AS-
525 to the newer version. Note that upgrading to the newer 
version only uses current database information. After 
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upgrading the AxTrax AS-525 version, you are required to 
download the panel information. 
If there is no SQL server installed, the Installation 
Requirements window opens. 

 
Figure 1: Installation Requirements window 

3. Click Install. 
If there is no SQL server installed, the following message 
appears in a dialog: “AxTrax AS-525 optionally uses 
Microsoft SQL Server 2005 Express. Would you like to install it 
now?” 
If you are installing AxTrax Client or if there is already an SQL 
server available on the computer network, click No. 
Otherwise, click Yes to install SQL Server Express. 

4. If the Microsoft® .NET 2.0 Framework is not installed on the 
computer, the following message appears in a dialog: 
“AxTrax AS-525 optionally uses Microsoft® .NET 2.0 
Framework. Would you like to install it now?”. 
Click Yes to install Microsoft® .NET Framework. 
Follow the on-screen instructions to complete the 
installations. 
After the installer has added any prerequisite software to 
the system, the AxTrax AS-525 Install Shield Wizard installs 
the software. 
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Figure 2: Install Shield Wizard 

Install the AxTrax Server on the computer that will connect 
to the access control panels and manage the database 
(see detailed instructions in Installing AxTrax Network Server 
Software, below). 
Then, install AxTrax Client on any additional computers. It is 
optional to install AxTrax Clients; however, it can be useful 
for monitoring the system from more than one PC. (See 
Installing AxTrax Network Client Software, on page 16 for 
AxTrax Client installation instructions.  

3.3 Installing AxTrax Network Server Software 

To install the AxTrax AS-525 Server: 
1. Wait while AxTrax AS-525 prepares to install. 

The Welcome to the Install Shield Wizard window opens. 
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Figure 3: Welcome to the Install Shield Wizard window 

2. Click Next. 
The Select Database Server window opens. 

 
Figure 4: Select Database Server window 

3. In Database Server, select the database server name.  
4. For database servers installed from the VeriTrax setup 

program ("SQL Server express"), add the instance name 
"\VeriTrax" to the database computer name. 

5. Set Connect using: to the default option (Server 
authentication using the Login ID and password below). The 
only conditions for setting the Windows authentication 
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credentials of current user option, is that you are using an 
existing SQL database installed using Windows 
authentication only and not from the VeriTrax Setup.  

6. Click Next. 
The Setup Type window opens. 

 
Figure 5: Select Setup Type window 

7. Select the Server option, and then click Next. 
The Destination Folder window opens. 

 
Figure 6: Destination Folder window 

8. To select a new destination folder for AxTrax AS-525, click 
Change, and browse to the required folder. 
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9. Click Next. The Ready to Install window opens. 

 
Figure 7: Ready to Install window 

10. Click Install. The installation process begins. 

 
Figure 8: Installing AxTrax AS-525 window 

When the installation is complete, the Install Shield Wizard 
Completed window opens. 
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Figure 9: Install Shield Wizard Completed window 

11. Click Finish and restart the computer, if requested. 
During Server installation, a dialog appears during 
installation of the HASP key protection software. 
Now, the AxTrax AS-525 Access Control System is fully 
installed on your computer. 

3.4 Installing AxTrax Network Client Software 

To install the AxTrax AS-525 Client: 
1. Wait while AxTrax AS-525 prepares to install. The Welcome 

to the Install Shield Wizard window opens (see Figure 3). 
2. Click Next.  

The Select Database Server window opens (see Figure 4). 
3. Click Browse to select the computer running the AxTrax SQL 

server. A list of Servers opens. 
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Figure 10: List of Servers 

4. Select the database server to use, and then click OK.  
The server name appears in the Select Database Server 
window, in Database Server. 

 
Figure 11: SQL Server selected for Client 

5. Set Connect Using to the same option that you used for the 
AxTrax Server installation. 

6. Click Next.  
The Setup Type window opens (see Figure 5). 

7. Select the Client option for AxTrax Server installation. 
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Figure 12: Select Client Setup 

8. Click Next. 
The Destination Folder window opens (see Figure 6). 

9. To select a new destination folder for AxTrax AS-525, click 
Change, and browse to the required folder. 

10. Click Next. 
The Ready to Install window opens (see Figure 7). 

11. Click Install. 
The installation process begins (see Figure 8). 
 When the installation is complete, the Install Shield Wizard 
Completed window opens (see Figure 9). 

12. Click Finish and restart the computer, if requested. 
Now, the AxTrax AS-525 Client software is installed on your 
computer. 

 

3.5 Firewall Settings 
Internal firewall settings may prevent the AxTrax Server from 
connecting to the SQL database or to panel control units using 
TCP/IP. 
For more information on how to configure a firewall, see 
 Appendix A Firewall Configuration, on page 118. Contact your 
system administrator or Rosslare Technical Support for further 
guidance. 
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3.6 SQL Server Settings  
After installing AxTrax, verify that the SQL server service on the 
computer is running and set to the required installation. 
For more information on SQL server settings, see  Appendix B 
SQL Service Settings, on page 122. 

 

Note: 
If SQL Express 2005 is installed (part of the installation 
package), the installation must be on the same 
Windows XP user account that is being used for 
AxTrax. 

 

3.7 AC-525 Video Enhancement Setup 
AxTrax AS-525 can connect with single or multiple ViTrax Servers 
installed in a LAN or WAN configuration (up to 10 ViTrax Servers 
are supported).  

 

Note: 
Make sure to check AxTrax AS-525 and ViTrax version 
compatibility.  

 

To Install ViTrax Server and Client applications, refer to the 
ViTrax Software manual.  

 

Note: 
When installing AxTrax AS-525, make sure that the 
ViTrax Server has already been installed on the same 
PC (no license is required for that ViTrax Server). 

 

To add AC-525 cameras: 
1. Activate the ViTrax Server and Client (see ViTrax Software 

manual). 
2. Define ViTrax Servers (see Connecting to ViTrax Server, 

page 85).  
3. Define communication of AC-525 cameras to the ViTrax 

Server (see Adding a Camera to AC-525 panel, page 87). 
4. Activate AxTrax AS-525 and configure it (see System 

Overview, page 20, and How to Set Up a Site, page 30). 
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4. System Overview 
AxTrax AS-525 is controlled through an easy to use interface, 
with a tree-view list of all aspects of the site setup, and a 
toolbar for standard operations. 

4.1 Starting the Software 
This section explains how to start the software and log in to the 
main window. 

To start AxTrax AS-525: 
1. Click the AxTrax AS-525 icon on the desktop, or select the 

program from the Rosslare folder in the Start menu. 
The AxTrax Software login dialog appears. 

 
Figure 13: AxTrax Software Dialog box 

2. Select an Operator name, and type a Password. 
 

 

Note: 
By default, the Administrator operator password is 
"admin". 

 

3. Click OK. 
The main AxTrax AS-525 window opens (see Figure 14). 

 

 

Note: 
The SW versions in the screenshots are exemplary 
only.  

 

4.2 The AxTrax AS-525 Main Window 
The entire central functionality of AxTrax AS-525 is available 
from its main window. 
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Figure 14: AxTrax AS-525 Main window 

The AxTrax AS-525 Main window is divided into five sections:  

Section Description 
1 Menu Bar Controls the software general operation and 

setup. For more information, see Menu Bar, 
page 22. 

2 Toolbar Has toolbar icons which users can use for the 
key tasks required in managing access 
control across a facility. The available icons 
change according to the view selected. For 
more information, see Toolbar, page 23. 

3 Tree View Allows users to configure, monitor, and 
control every aspect of access control. For 
more information, see Tree View, page 26. 

4 Display Area Displays all items within the tree view 
selected element. 

5 Status Bar Displays general status information, such as: 
Operator name, Client/Server mode, system 
readiness, system download, date, and time. 

 

 

 

 

 



System Overview 

AS-525 AxTrax Software Installation and User Guide Page 22 
 

4.3 Menu Bar 
The menu bar controls the general operation and setup of the 
software. 

4.3.1. File Menu 

The File menu has five options: 

Menu Select Menu item to… 
Logon Log on to the AxTrax AS-525 system. 

When you log on as a new Operator, the 
previous Operator is logged out. 

Logoff Close the current Operator account. 
The AxTrax software is minimized to the 
taskbar. 

SQL Server 
Logon 

Log on to the SQL database server. 

ViTrax Server Log on to the ViTrax server. 
Exit Exit the AxTrax AS-525 software. 

4.3.2. Tools Menu 

Use the Tools menu to manage the database and set software 
preferences. The menu has four options: 

Menu Select Menu item to… 
Database Open the Database window to back up the 

database or set a scheduled backup, and 
to import or export AxTrax AS-525 and/or 
VeriTrax AS-215/AS-225 configuration states 
and Events logs. 

Options Set software options and preferences, 
including national holidays, event 
highlighting, pop-up alarms, custom user 
information fields, and Reports settings. 

Import/Export 
Data 

Import/export user information from/to an 
Excel spreadsheet file. 
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Menu Select Menu item to… 
AxTrax Server 
Daylight 
Saving 

Define the daylight saving time (Windows or 
other). 

4.3.3. Help Menu 

The help menu has one option: 

Menu Select menu item to… 
About View software version and license 

information. 

4.4 Toolbar 
The toolbar controls key tasks required to manage access 
control across a facility. When a new element is selected from 
the tree view, the toolbar icons change to suit the selected 
element. 
The following toolbar icons are available: 

4.4.1. General Icons 

Icon Name Click icon to… 

 

Open Door 
Manually 

Open the Door Manual Operation 
window. See Controlling the Door 
Manually, page 92. 

 
Print Send the current display area view to 

the printer. 

 
New Create a new element of the selected 

type. 

 
Edit Edit the selected element. 

 
Delete Delete the selected item. 

 Delete All Remove all users or cards from the 
selected list. 
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4.4.2. Events Icons 

Icon Name Click icon to… 

 

Pause Halt the display of Events in the display 
area. New Events are shown again 
when the Pause button is clicked a 
second time. 

 

View Events 
within the last 
Hour 

Display all Events that occurred within 
the last hour. Click the dropdown arrow 
to change the view. 

 

View Events 
within the last 
Day 

Display all Events that occurred within 
the last two days. Click the drop-down 
arrow to change the view. 

 

View Events 
within the last 
Week 

Display all Events that occurred within 
the last week. Click the drop-down 
arrow to change the view. 

 

View 
Periodical 
Events 

Display all Events that occurred within a 
selected period. Click the drop-down 
arrow to change the view. 

 
View All 
Events 

Display all Events. Click the drop-down 
arrow to change the view. 

 

Antipassback 
Forgive 

Open the Antipassback Forgive 
window to allow the operator to 
cancel an Antipassback restriction for 
the selected user. 

 
Show User Open the User window for the selected 

user. 

 
Clear Alarm Open the Alarm Details window to 

allow the operator to reset the alarm. 

 
Archive Open the Archive Camera Window for 

the selected Video Stream. 

4.4.3. Network Icons 

Icon Name Click icon to… 

 
Update 
Firmware 

Send a firmware update to the selected 
access control panel. 
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Icon Name Click icon to… 

 

One Reader 
per Door 

Display a new panel with a single reader 
per door (with/without an extension 
panel). See Adding Access Control 
Panels, page 38. 

 

Two Readers 
per Door 

Display a new panel with two readers 
per door (with/without an extension 
panel). See Adding Access Control 
Panels, page 38. 

 

Set Time Set the time on the selected Access 
Control Panel. See Setting the Time and 
Date, page 101. 

 

Find Panels Find and update panels within the 
network. See Detecting Panels 
Automatically, page 101. 

 

Modem 
Manual 

Open the Modem Status window to 
allow the operator to connect or 
disconnect the modem and change 
the connection password. 

 

Camera View a list of connected cameras, and 
assign the cameras to panels. See 
Adding a Camera to AC-525 panel, 
page 87. 

4.4.4. Panel Icons 

Icon Name Click icon to… 

 

Manual 
Reader 

Change the operation mode of the 
readers on the selected panel. See 
Changing the Reader Mode, page 93. 

 

Control 
Output 
Manually 

Change the settings for the outputs on 
the selected panel. See Controlling 
Outputs Manually, page 94. 

 

Control 
Input 
Manually 

Change the settings for the inputs on 
the selected panel. See Manually 
Disarming Inputs, page 95. 
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Icon Name Click icon to… 

 

Control 
Siren 
Manually 

Test the siren for the selected panel. See 
Testing the Siren, page 96. 

 

Manually 
Download 
new Panel 
Data 

Update the selected panel. See Manual 
Download of Panel Data, page 102. 

 
Manually 
Download 
failed Data 

Download the entire Panels Failed 
database. See Downloading Failed 
Data, page 103. 

4.4.5. Departments\Users Icons 

Icon Name Click icon to… 

 
Find Users Search for a user in the database. 

 
User 
Counter 

View the current User count value. See 
Testing User Counters, page 104. 

4.4.6. Reports Icons 

Icon Name Click icon to… 

 
Produce 
Report 

Produce the selected report. 

4.5 Tree View 
The Tree View allows users to configure, monitor, and control 
every aspect of a facility's access control network. 
When the user selects an element from the tree, its contents 
are shown in the main display area, and the toolbar icons 
change to suit the selected element. 

4.5.1. Events 

The Events log displays a log of every time access is granted or 
denied, for every door on a site. Monitoring for potential door 
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tampering or forced entry is logged, and displays of internal 
system warnings, including Video stream archive, are saved to 
the ViTrax database. 
 

4.5.2. Status Map 

The Status Map displays the status of every door, reader, and 
alarm in the facility on user-selected floor plans. 
The system can display multiple nested status maps, allowing 
users to show either the complete access control network or a 
specific area in detail.  
 

4.5.3. Networks 

A network is a group of up to 32 access control panels. The 
AxTrax Server connects to the panels across the panel network. 
AxTrax AS-525 can support up to 1,023 panel networks. For 
more information, see Defining a Network, on page 32.  

 

Note: 
To work with 65 panels or more, a HASP security key 
must be connected to the AxTrax Server machine.  
See System Requirements, page 9. 

 

4.5.4. Time Zones 

A time zone defines a weekly time period or set of time 
periods, for example, "Office Hours" or "Out of Office Hours". 
Door access rights, alarms, and input and output behavior can 
all be set to behave differently within each Time Zone. For 
more information, see Defining Time Zones, page 31. 
 

4.5.5. Access Groups 

An Access Group defines when each reader on the site will be 
available for access. All site personnel are assigned to 
appropriate Access Groups. For more information, see 
Creating Access Groups, page 51. 
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4.5.6. Input and Output Groups 

Input and Output groups define sets of outputs or inputs that 
should be managed together within a panel. For more 
information, see Configuring the Inputs, page 50. 
 

4.5.7. Access Areas and Global Antipassback 

A facility can be subdivided into several access areas in order 
to configure and manage it more effectively. Antipassback 
rules can be applied to each access area to prevent one 
user's card or entry code from being used for two subsequent 
entries, and to prevent a second entry without a previous exit.  
For more information, see Creating Access Areas and Global 
Antipassback rules, page 63. 
 

4.5.8. Cards 

Lists all cards in the system with their statuses, and allows the 
manual or automatic addition of cards to the system. For more 
information, see Defining Cards, page 53. 
 

4.5.9. Departments and Visitors 

Lists all departments and users, as well as visitors. Each user is a 
member of a department. For each user, it is possible to assign 
a card and/or a PIN code, set access rights, personal details, 
and include an identification photograph.  
Can also create visitors with their specific associated rights. 
For more information, see Defining Users and Departments, 
page 56. 
 

4.5.10. Holidays 

Defines annual holiday dates. Using Time Zones, it is possible to 
set special access behaviors for holiday time. 

 

Note: 
Selected holiday dates can also be imported into 
AxTrax AS-525 from Microsoft® Outlook®. 
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4.5.11. Operators 

Operators are people with access to the AxTrax software. The 
default operator names are administrator, engineer, and 
security. 
Different operators have wider or more restricted security rights, 
from complete control over the system to the ability only to 
view one section. All Operator passwords are case-sensitive. 
 

4.5.12. Reports 

AxTrax can produce various reports, including usage reports, 
attendance records, visitors, and roll calls. The AxTrax Report 
Wizard allows users to design their own custom reports, based 
on their needs. For more information, see Reports, page 98. 
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5. How to Set Up a Site 
This section outlines a recommended step-by-step process for 
configuring AxTrax AS-525 for a site. 

Step Action Section 

 
Define the Time Zones See Defining Time Zones, 

page 31.  

 
Define a Network See Defining a Network, 

page 32. 

 
Define and Configure an 
Access Control Panel 

See Adding Access 
Control Panels, page 38. 

 
Configure the Doors See Setting Door 

Properties, page 44. 

 
Configure the Readers See Configuring the 

Reader, page 47. 

 
Configure the Inputs See Configuring the 

Inputs, page 50. 

 
Create Access Groups See Creating Access 

Groups, page 51. 

 
Define new Cards See Defining Cards, 

page 54. 

 
Set up new Users See Defining 

Departments, Users, and 
Visitors, page 56. 

 
Define Access Areas and 
Antipassback 

See Defining Access 
Areas and Antipassback, 
page 68. 

 
Set Panel Links See Setting Panel Links, 

page 70. 

 
Create a Status Map See Creating Status 

Maps, page 75. 
 

The AxTrax AS-525 system performs an automatic data 
download for any parameter related to the hardware. If 
panels are connected and active, "Downloading" appears on 
the status bar after any downloaded parameter change. 
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"Ready" appears when download is complete; however, it may 
also appear after a failed download. 

 

Note: 
It is the operators’ responsibility to verify that the 
download operation succeeded or failed. This can 
be verified in the system event list or by checking the 
failed download data manually; see page 103 . 

5.1 Defining Time Zones 
A time zone is a group of periods within a week. Door access 
rights, as well as input and output behavior, can all be set to 
behave differently for each time zone. Many operations can 
be automatically enabled or disabled within a selected time 
zone. 
The Time Zone Properties window displays the selected periods 
for each day in the week. It is possible to set a maximum of 
eight different periods. 
 

To set a new time zone: 
1. In the tree view, select Time Zones. 
2. On the Time Zones toolbar, click the New icon. 

The Time Zone Properties window opens. 

 
Figure 15: Time Zone Properties window  
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The Time Zone Properties window contains the following fields: 

Field Description 
Description Type a name for the time zone. 
Start/End Enter a start time and end time for each 

period. 
Sun–Hol. Select the days on which the time period is 

within the time zone. 
The "Holiday" day can be set to include 
national holidays. 

Clear All Clear all the time zone settings. 
 

3. In Description, type a name for the time zone, set the 
required time periods, and then click OK. 
The window closes and the display area displays the new 
time zone. 

 

Note: 
Time settings can be copied-and-pasted between 
time zones. Right-click a time zone and select Copy 
from the shortcut menu. Then, right-click a second 
time zone and select Paste from the shortcut menu. 

 

5.2 Defining a Network 
A network is a group of up to 32 access control panels. AxTrax 
AS-525 communicates with each access control panel that is 
part of the network.  
The Network window includes the following information: 
• The network's name, address, and status 
• The DIP switch settings for the communication speed 
• The type of network connection and the connection 

settings 
 

To access the network window: 
1. In the Tree view, select Networks. 
2. On the Network toolbar, click the New icon. 

The Network window Options tab is displayed. 
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Figure 16: Network window – Serial Network Options tab  

The Network window contains the following fields: 

Field Description 
Description Type a name for the network. The network 

address is displayed to the right of the 
network name. 

Enabled Select the checkbox when the network is 
connected and operational. 

Network 
Type 

Select the Network type: Serial, TCP/IP, or 
Modem.  
For TCP/IP connection, see the resulting 
Options tab in Figure 17. 
For Modem connection, see the resulting 
Options tab in Figure 18. 
See Network Configuration, on page 123. 

Com Port, 
Speed 

Set the connection type and speed.  
For TCP/IP connections, set the IP Address.  
See Network Configuration, on page 123. 
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Field Description 
Configuration 
button (for 
TCP/IP LAN 
and Modem 
network 
types) 

Open the Configuration window to set 
communication preferences. This button 
appears when selecting a Modem or TCP/IP 
LAN network. For more information, see 
Network Configuration, page 123. 

Advanced 
button 

Set the Maximum Communication timeout for 
panel response time; Set to "Slow" if panel 
response is inconsistent. This condition may 
occur due to a busy TCP/IP network, or when 
connecting panels on a WAN in remote sites. 

 

3. In Description, type a name for the new Network, and 
select the Enabled checkbox. 

4. Select the Network type. 
If you select TCP/IP, the Options tab appears as follows: 

 
Figure 17: Network window – TCP/IP Network Options tab 
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If you select Modem, the Options tab appears as follows: 

 
Figure 18: Network window – Modem Network Options tab 

5. Set the connection settings. 
6. For a Modem, click the Configuration button to set dialing 

preferences for the computer's and the receiving modems. 
7. For a TCP/IP LAN, click the Configuration button to locate 

the hardware on the local network.  
For more information on how to configure an access 
control network, see Network Configuration, page 123. 
Check with your system administrator for more information, 
or contact Rosslare technical support (see Technical 
Support, page 130). Clear the Enabled checkbox, if you 
want to halt communication to panels on the network. 

 

Note: 
Access control panels connect to a TCP/IP network 
via MD-N32 TCP/IP to Serial converter, or by using the 
on-board module in AC-225IP or AC-525. Refer to the 
relevant hardware installation guides for more 
details. 

8. For all types of networks, set the DIP switch on the Access 
control panel hardware to match the diagram at the top 
of the screen. 

 

Note: 
After changing the DIP switch, make sure to power-
down and then power-up the panels. 



How to Set Up a Site 

AS-525 AxTrax Software Installation and User Guide Page 36 
 

9. Click the General tab. 

 
Figure 19: Network window – General tab 

10. To use the time zone of the AxTrax Server for the panel 
network, select the option Panel network using AxTrax 
Server time zone (default), and then continue with Step 12.  

11. To select a different time zone for the panel network, select 
the option: Panel network using different time zone. 
The Network Time Zone area opens. 

 
Figure 20: Network General Tab - Network Time Zone Area 
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The Network Time Zone area contains the following fields: 

Field Description 
Select a Time 
Zone (Windows 
Date and Time) 

From the drop-down list, select the desired 
time zone. 

Daylight Time Select the new hour at the time that 
daylight saving time begins. 

Start DST (time) Select the hour that daylight saving time 
begins. 

Stop DST (time) Select the hour that daylight saving time 
ends. 

Every year Select the Every year checkbox, to set a 
day in one of the weeks of a defined 
month to automatically begin and end 
daylight saving time every year. 
Clear the Every year checkbox, to set a 
date for one-time setting of the beginning 
and end of daylight saving time. In this 
case, a new date has to be set each year.  

Start DST (date) If Every year is not selected, select the 
commence date for daylight saving time. 

Month, Week, 
Day of Week 

These fields are enabled when the Every 
year checkbox is selected. Select the 
month, week within the month, and day of 
the week, when daylight saving time is to 
begin every year. 

Stop DST (date) If Every year is not selected, select the end 
date for daylight saving time. 

Month, Week, 
Day of Week 

These fields are enabled when the Every 
year checkbox is selected. Select the 
month, week within the month, and day of 
the week when daylight saving time is to 
end every year. 

12. Set the Daylight Saving Time definitions, according to the 
field descriptions in the table. 

13.  Click OK. 
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5.3 Adding Access Control Panels 
Every network is a cluster of access control panels. Each Panel 
can be configured using two readers per door, when the door 
acts as both the entrance and exit to an area of the site. In its 
standard form, each access control panel has two readers 
and can be configured either as a single door with two 
readers, or as two doors with one reader per door. When using 
an optional MD-D02 reader expansion board (supported by 
AC-225 or AC-525), each panel has four readers and can be 
configured as four door panels. 
Use two readers per door when one door acts as both the 
entrance and exit to an area of the site. When only an entry 
reader is required, use one reader per door. 
For example: 
• Use configuration with two readers per door set to IN and 

OUT, to produce attendance reports. 
• Use one reader per door configuration to control two 

doors with an IN reader only (premises will be exited using 
a REX switch or a mechanical door handle only). 

5.3.1. General Panel Settings 

The General tab of the Door Controller Panel Properties 
window displays the following: 
• The panel's address and status 
• The DIP switch settings for the panel  

If panel expansion boards are installed, it also displays: 
• The input and output connections for the panel 
• The panel's hardware version 

Refer to AC-525 Hardware manual for further details. 
 

To add a panel: 
1. In the tree view, click Networks. 

The available networks are listed in the display area. 
2. Select a network. 

For one reader per door on the Access Control Panel, click 
the One Reader per Door icon. 
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For two readers per door on Access Control Panel, click the 
Two Reader per Door icon. 

 

Note: 
Make sure that the Dip Switch 3 position on the panel 
corresponds with its position demonstrated in the 
panel properties window. 

The Door Controller Panel Properties window opens. 

 
Figure 21: Door Controller Panel Properties window 

The Door Controller Panel Properties window contains the 
following fields: 

Field Description 
Description Type a description for the panel. 
Panel 
Address 

Type an address number for the panel.  
The network's address is displayed to the left of 
the panel address. Valid entries are 1-32. 

Hardware 
Version 

Select the appropriate panel hardware type. 

Enabled Select the checkbox to activate this panel. 
Clear the checkbox if the panel is not 
connected. 

Upload 
Previous 
Events 

Select the checkbox to send previous logged 
events from the panel. 
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Field Description 
Inputs Displays the input connections for the panel. 
Outputs Displays the output connections for the panel. 
Test Click to test that the panel is correctly 

connected to the computer. 
The Test Panel window displays hardware 
details, including hardware type, firmware and 
bootloader versions, and indicates whether an 
I/O expansion board is installed on the panel. 

 

3. Select the appropriate Hardware Version for your panel. 
Ensure that the DIP switch on the panel matches the 
diagram at the top of the screen.  

4. Click OK.  
The window closes and the display area displays the new 
panel. 

 

Note: 
After a panel is connected, AxTrax AS-525 can also 
detect and add it automatically. For more 
information, see Detecting Panels Automatically, 
page 101. 

5.3.2. Configuring the Panel 

Each panel has individual settings for antipassback behavior 
and for recording events. 
Once the panel is connected, configure a panel's options from 
the Options tab in the Door Controller Panel Properties window. 

 

Note: 
When there is communication with the panel, the Tx 
and Rx LEDs flash. 

 

To configure a panel: 
1. In the tree view, click Networks. 

The available networks are listed in the display area. 
2. In the tree view, expand a network and select a panel to 

configure. 
3. Click the Edit icon  

The Door Controller Panel Properties appears.  
4. Click the Options tab. 
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The Panel Properties Options tab opens. 

 
Figure 22: Door Controller Panel Properties Options tab 

The Options tab contains the following fields: 

Field Description 
Door 
Antipassback  

From the Automatic Antipassback 
dropdown menu, select the time zone for 
door Antipassback rules to apply.  
Choose the antipassback severity: 
• Hard - When hard Antipassback is 

selected, an event is generated and the 
door does not open. 

• Soft - When soft Antipassback is selected, 
an event is generated and the door 
opens. 

From the IN/OUT readers list, select the 
checkboxes to apply Antipassback 
restrictions to Reader 1 thru Reader 4, as 
required. The reader Antipassback is 
enabled when the checkbox is selected 

 

Note: 
The Door Antipassback feature is now available 
for up to four doors (when MD-D02 is in use). To 
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Field Description 
activate Antipassback, select the IN Reader / 
OUT Reader checkbox next to the appropriate 
reader/s. Interlock (for Panels with 2, 4 Doors only) 
is preserved in order to open another door when 
the current door is closed. 

 

Events Filter Click Select to open the Events Filter and 
select the Events that this Panel should 
record. Set the filter's operation method: 
• Always Active - Only the selected events 

are recorded by the panel. 
• Active when panel disconnected - If the 

panel is disconnected from the AxTrax 
server, only the selected events are 
recorded. When the panel is connected 
to the server, all events are recorded. 

 

Note: 
In the default configuration, some events are 
filtered and may not be seen in the display area - 
events view. 

 

Door Interlock Select the Enabled checkbox to enable 
Door Interlock. Select the Door 1-4 
checkboxes to apply the Door Interlock 
restrictions to Doors 1-4. 
The Door Interlock function is only enabled 
when the Enable checkboxes and a 
minimum of two Doors are selected. 

No 
Communication 
Event (min:sec) 

Select a period of time in minutes and 
seconds, to determine when the system 
generates a No Communication event.  
If there is no communication from the 
AxTrax server for a period longer than the 
setting defined, the No communication 
with server event is generated in the panel. 

AC-525 USB 
Storage  
(Applicable 
when 
connected to 

From the Alarm Threshold Range (%) 
dropdown menu, select the percentage of 
available memory consumed, to 
determine when the system generates the 
"USB Disk Low Level" event.  
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Field Description 
AC-525 only) The USB disk on key status is monitored 

roughly once an hour. Therefore, be sure to 
select an acceptably low threshold level, 
and consider that any related alarm may 
be set off up to one minute after the 
actual event occurs. 

Time Zone Select the time zone for the location using 
the Location Time Zone dropdown menu. 
Check the Daylight Saving Time checkbox 
to enable daylight saving time. 
Clear the checkbox to disable daylight 
saving time. 
Click Windows Time Zone to apply 
Windows time zone or click Manual Time 
Zone to adjust manually. 

 

Note: 
Time Zone selection is required for proper 
synchronization with the AC-525’s video board. 

 

 

5. Click the Options tab. 
6. Set Antipassback and event filtering for this panel, and 

then click Test. 

 
Figure 23: Panel Connection Test 

The test screen displays the following information: 

Field Description 
Firmware 
version Displays the firmware version of the board. 

Bootloader Displays the bootloader version of the board. 
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Field Description 
version 
Hardware Displays the hardware name. 
Supervised 
Inputs 

Displays the panel is secure in case of 
tampering. 

MD-IO84 Indicates whether or not MD-IO84 exists.  
MD-D02 Indicates whether or not MD-D02 exists. 
MD-IPAV1 Displays the AC-525 Video board version 

number. 
7. Click OK.  

The window closes and the display area displays the new 
panel. 

 

Note: 
A panel configuration can be copied-and-pasted 
between panels. Right-click a panel, and select 
Copy from the shortcut menu. Then, right-click a 
second panel, and select Paste from the shortcut 
menu. Properties can only be copied between 
panels of the same door controller type and 
hardware version. 

 

5.4 Setting Door Properties 
Each Panel controls one or two doors, or four doors if the MD-
D02 reader extension board is connected. Each door can be 
configured individually. 
The Door Controller Properties window displays the following: 
• The settings for unlocking and relocking 
• The time available before the door relocks or records 

alarm events 
• The camera that is used for Pop-up and Snapshot, on the 

Server application only, and when the door is held open or 
forced open  

To set door properties: 
1. In the tree view, click Networks. 

The available networks are listed in the display area. 
2. Select a network and expand a panel in the tree view. 
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Select a door to set its properties. 
3. Click the Edit icon. 

The Door Controller Properties Window opens. 

 
Figure 24: Door Properties window 

The Door Properties window contains the following fields: 

Field Description 
Description Type a name for the door. 
Auto Relock Select the event that causes the door to 

relock automatically.  
REX 
enabled 

A Request to Exit unlocks the door for a user-
defined duration. Select the checkbox to 
allow Requests to Exit for this door. The door 
REX input locations depend on panel 
configurations; they can be seen in the Panel 
properties window.  

First person 
delay on 
automatic 
unlock 

Sets the door's behavior during an automatic 
unlock time zone. Select the checkbox to 
require that during the selected Time Zone, the 
door remains locked until the first user opens it. 
The automatic unlock time zone is selected in 
Panel Links, by selecting the output 
corresponding to that door. See Setting Panel 
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Field Description 
Links, page 70. 

Door output 
polarity is 
Normal 
Closed 

Select this checkbox to ensure Fail Safe door 
opening if the Fail Safe door Lock Device 
power fails. Once enabled, the door output 
relay is activated when the door is closed, and 
is deactivated when the door is open. In this 
configuration, the Fail Safe lock device should 
be wired to the door relay N.O. (Normal 
Open) and COM (Common) terminals. 

Manual 
Door Open 
Enabled 

Select this checkbox to allow operators to 
adjust the door manually. See Controlling the 
Door Manually, page 92. 

Door open 
time 

Set the duration for which the door stays 
unlocked. 

Extended 
door open 
time 

Set the duration for which the door stays 
unlocked for users with Extended door open 
rights. 

Door held 
open 

Set the duration for which the door can be 
held open without raising an alarm event. 
Select the checkbox to use this timer; for the 
Server application, the Popup and Snapshot 
section opens. 

Door forced 
Open 

Set the duration following which when the 
door is forced open, an event occurs.  
Select the checkbox to use this timer; for the 
Server application, the Popup and Snapshot 
section opens. 

Camera 
Available 
only with 
AC-525 

When Door help open or Door forced open 
options are selected, the Popup and Snapshot 
section opens. You must select the name of 
the camera added to your system in order to 
enable automatic video Popup and Snapshot 
features. 

 

4. Configure the door as required, and then click OK. 
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5.5 Configuring the Reader 
A panel can be connected to two readers or four readers, 
when the MD-D02 extension board is connected. 
The reader properties window has two tabs:  
• The General tab sets the reader general operation settings 
• The Options tab sets access options for the reader 

To configure a Reader: 
1. In the Tree View, click Networks. 

The available networks are listed in the display area. 
2. Select a network and expand a panel in the tree view. 
3. Expand a door within the panel, and select a reader to set 

its properties. 
4. Click the Edit icon. 

The Reader Properties Window opens. 

5.5.1. General Reader Operation Settings 

The Reader Properties General tab displays: 
• The settings for how the reader will operate 
• The type of reader that is being used 

 
Figure 25: Reader Properties General tab 
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The Reader Properties General tab contains the following: 

Field Description 
Description Type the name of the reader. 
Operation 
Mode 

Select how the reader operates. 
• Inactive: The reader is not in use. 
• Card Only: The reader will accept RFID cards 

only. 
• PIN Only: The reader will accept PIN inputs 

only. 
• Card or PIN: The reader will accept both 

cards and PIN codes. 
• Desktop: The reader is inactive, but is being 

used to record new cards on the computer. 
• No Access Mode: The reader will not grant 

access to any users. 
Direction Select whether the reader is allowing entry 

into the area or exit out of the area.  
Secured 
(Card+PIN) 
time zone 

Select a time zone during which access should 
be granted only after both the card and PIN 
are entered. 
The PIN must be entered within 10 seconds of 
card entry. 

Open Door Select the checkbox to allow the reader to 
unlock the door. 

Deduct User 
Counter 

Select the checkbox to record this entry 
against the user's entry allowance counter. 
See General User Properties, page 57. 

Reader type Select the data transmission type for the 
reader hardware. 

Keypad 
type 

Select the data transmission type for the type 
of keypad hardware. 

Check 
facility code 
only 

Select the checkbox to allow access to any 
user assigned to a facility listed in the selected 
list of facilities. 
The list of facilities is defined in the Options tab. 
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Field Description 
AYCW6500 
Biometric 
Reader 

Select the checkbox to interface with the 
AYC-W6500 biometric reader and its PC 
application, BioTrax. 

 

5. Configure the reader as required, and then click OK. 
 

5.5.2. Reader Access Options 

The Reader Properties Options tab displays: 
• Timed antipassback settings for the reader 
• Restricted site access settings 
• The camera used to take snapshots and view pop-up 

videos triggered by the reader 

 
Figure 26: Reader Properties Options tab 

The Reader Properties window contains the following fields: 

Field Description 
Automatic 
Antipassback 

Select whether to apply antipassback rules.  
To set Time Zones, see Defining Time Zones, 
page 31.  

Hard When hard antipassback is selected, an 
event is generated and the door does not 
open. 
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Field Description 
Soft When soft antipassback is selected, the 

door opens but an event is generated. 
Time Set the number of minutes before a user 

can reenter using this reader. 
Add from List Click to add sites from a list. 

The site list applies only when the Check 
site code only checkbox in the General tab 
is selected. 

Add Manually Click to enter a site code. 
The site list applies only when the Check 
site code only checkbox in the General tab 
is selected. 

Remove Remove the selected site from the list. 
Camera 
Available only 
with AC-525 

Select the name of the camera that will 
take snapshots or which will pop up when 
triggered by this reader.  
For example, the camera named 1\Panel 
1\Camera A AC-525. 

Configure the reader as required, and then click OK. 

5.6 Configuring the Inputs 
Each panel has four inputs. Using MD-IO84 adds another eight 
inputs (a total of 12 inputs), and using MD-D02 adds four inputs 
(a total of 8 inputs). Some inputs are dedicated and have 
default functionality, and some are for general purpose. The 
panel properties window displays the settings for each input.  
Input type is programmed individually, regardless of whether it 
is a dedicated input or for general purpose use. 

To configure an Input: 
1. In the Tree View, click Networks. 

The available networks are listed in the display area. 
2. Select a network and expand a panel in the Tree View. 
3. Select Inputs, then select an input from the display area. 
4. Click the Edit icon. The Input Properties Window opens. 
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Figure 27: Input Properties window 

The Input Properties window contains the following fields: 

Field Description 
Description Type a name for the input. 
Type Select the type of input to be monitored. 

• Normally Open/Close: An input either in an 
open or closed state. 

• Normally Open/Close 1 Resistor: An input in 
an open, closed, or trouble state. This option 
is only available for supervised inputs. 

• Normally Open/Close 2 Resistors: An input in 
an open, closed, or trouble state, with 
additional checks for short-circuit and open-
circuit tampering. This option is only available 
for supervised inputs. 

For more information, refer to the Access 
Control Panel hardware manual.  

Activity start 
delay 

Set the delay time before this input becomes 
active. Note that on normally open input, the 
delay starts once the input contact is closed. 
On normally closed input, the delay starts 
once the input contact opens. 

 

5. Configure the input as required, and then click OK. 

5.7 Creating Access Groups 
An access group includes a list of door readers and the time 
zones during which each of those door readers are available 
for access. Every user is assigned to an access group. 
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The Access Group window lists all the door readers defined in 
the database, and the time zones during which they can be 
accessed. 

To create an access group: 
1. In the Tree View, expand the Groups element and select 

Access Groups. 
2. On the toolbar, click the New icon. The Access Group 

window opens. 

 
Figure 28: Access Group window 

The Access Group window contains the following fields: 

Field Description 
Description Type a name for the access group. 
Reader Lists every reader defined in the database. 
Group time 
zone 

Select the time zone during which this reader 
should be accessible. 

 

3. Type a name for the access group, and set time zones for 
readers, as required.  

4. Click OK. The window closes, and the display area displays 
the new access group. 

 

Note: 
Access settings can be copied-and-pasted 
between access groups. To do so, right-click an 



How to Set Up a Site 

AS-525 AxTrax Software Installation and User Guide Page 53 
 

access group, and select Copy from the shortcut 
menu. Then, right-click a second access group, and 
select Paste from the shortcut menu. 

5.8 Creating Input Groups 
Input groups are a collection of Inputs from one or more panels 
that can be used in panel links to perform advanced 
operations. 

To set an Input Group 
1. In the Tree View pane, expand the Groups view. 
2. Select Inputs groups, and right-click the selection  

Or, Click the New icon. 
A new input group is created. 

3. Expand the network(s) and panels. 
4. Finally, select the checkboxes of all relevant Inputs. 

 
Figure 29: Input Group Creation 

5.9 Creating Output Groups 
Output groups are a collection of Outputs from panel or 
panels that can be used in panel links to perform advanced 
operations, such as Elevator control. 

To set an Output Group 
1. In the Tree View pane, expand the Groups view. 
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2. Select Outputs groups, and right click the selection  
Or  Click the New icon to create a new Output group. 
A new Output group is created. 

3. Expand the Network(s) and panels.  
4. Finally, select the checkboxes of all relevant Outputs. 

 
Figure 30: Output Group Creation 

 

5.10 Defining Cards 
The AxTrax database maintains a list of every user card or PIN 
that has ever been assigned. The Add Cards window defines: 
• The type of reader needed to read the card 
• The number of cards to create 

 

To Define Cards: 
1. In the Tree View, select Cards. 
2. On the toolbar, click the New icon.  

The Add Cards window opens. 
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Figure 31: Add Cards- Manual tab 

The Add Cards – Manual tab contains the following fields: 

Field Description 
Reader Type Select the type of reader appropriate for 

these cards. 
Cards quantity Type the number of cards to add. 
Start from Type the number of the first card in the set. 
Facility code Type the site code for these cards. 

This field is not available for all reader types.  
New Users Select this checkbox to create a new user 

in the database for each new card.   
User Number 
started from 

Enter the user number for the first user in the 
set. This field is only available when the New 
Users checkbox is enabled. A maximum of 
1000 users can be generated at one time.  

3. Set fields as required, and then click Add. 
A dialog reports that the operation has been completed. 

5.10.1. Enrolling cards using MD-08 

This option is available for users with the MD-08 unit on-board. 
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To define MD-08: 
1. In the Tree View, select Cards. 
2. On the toolbar, click the New icon. The Add Cards window 

opens (see Figure 31). 
3. Click the MD-08 tab. The MD-08 tab is displayed. 

 
Figure 32: Add Cards - MD-08 tab 

4. Select your Reader type, and then Com Port. 
5. Click Add. 

5.11 Defining Departments and Users 
Every user is grouped within a department. AxTrax AS-525 stores 
contact details for each user, associated card details, and 
user access rights. 
The User Properties window has four tabs: 
• General tab displays identification and control information 
• Codes tab displays information about cards associated 

with the user 
• Details tab records user contact details 
• User Fields tab stores user-defined data 

To create departments: 
1. In the tree view, select the Departments\Users element. 
2. To create a new Department, click the New icon. 
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The Departments dialog appears. 

 
Figure 33: Department dialog 

3. Type a name for the department, and then click OK. 
To create users: 
1. Expand the Departments\Users element and select a 

Department for the new user. 
2. On the toolbar, click the New icon.  

The User Properties window opens.  

5.11.1. General User Properties 

The General tab displays: 
• User identification information 
• User validity settings 
• Access rights for the user 

 
Figure 34: User Properties Window 
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The General tab contains the following fields: 

Field Description 
Add/Remove Click to add a photo of the user, or to 

remove an existing photo. Note that the 
selected photo aspect ratio should be 
1.25 H x 1.00 L. Otherwise, the photo may 
be distorted. 

First name Type the user's first name. 
Middle name Type the user's middle name. 
Last name Type the user's last name. 
User number Type a unique user number to identify 

the user. 
Department Select the user's department. 
Access group Select the user's access group. 
Select color Click to select which color to use to 

highlight this user when the user 
generates access events. 
User highlighting must be activated in 
Tools > Options > General tab. 

Location Click to display a log of doors accessed 
by this user. 

Valid date/time 
from 

Select the date/time from which the 
user's access rights begin. 

Valid date/time 
until (checkbox) 

Select the checkbox to set the 
date/time on which the user's access 
rights end. 

Valid date/time 
until (field) 

Select the date/time on which the user's 
access rights end. 
This field is only available when the 
checkbox has been enabled. 

Enabled Select the checkbox to set an access 
rights countdown counter for this user. 
When the counter reaches zero, the 
user's access rights end. 
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Field Description 
Test Click to check the current state of the 

user's countdown counter. 
Set new counter 
(checkbox) 

Select the checkbox to set a new 
countdown counter value for this user. 

Set new counter 
(field) 

Select a new countdown counter value 
for this user. 
This field is only enabled when the Set 
new counter checkbox is selected. 

 

Field  Description 
Rights Antipassback 

immunity 
Select the checkbox to override any 
Antipassback restrictions for this user. 

 Extended 
door open 
time 

Select the checkbox to entitle this user to an extended unlocked door duration. The extended 
duration is set for each door. See Setting Door Properties 

Setting Door Properties, page 44. 

Links Access 
Granted 
command 

Select the checkbox to activate a 
user-defined set of inputs or outputs 
for this user. 
The operations are set in the Links 
window. See Setting Panel Links, 
page 70. 

 Access 
Denied 
command 

Select the checkbox to activate a 
user-defined set of inputs or outputs 
for this user. 
The operations are set in the Links 
window. See Setting Panel Links, 
page 70. 

 User selected 
Output group 

Select an output group for this user. 
The outputs will be triggered every 
time the user accesses a door, as 
specified in the Links window. See 
Setting Panel Links, page 70. 
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 Handicapped 
check-box 

Select the checkbox to activate a 
dedicated output a short time after 
the door is unlocked. The outputs are 
set in the Links window. See Setting 
Panel Links, page 70. 

 

5.11.2. Associated Cards and Codes 

The Codes tab displays: 
• The cards (up to 16 cards) and the PIN code assigned to 

this user. 
• Whether biometric fingerprint templates are enrolled for 

this user; only valid when using Rosslare’s AYC-W6500 
Biometric reader and BioTrax PC application. 

 
Figure 35: User Codes tab 

The Codes tab contains the following fields: 

Field Description 
Facility Code The site code assigned to this card. 
Card Number The unique number of this card. 
Status Select the status of the card. Inactive cards 

cannot gain access to the facility. 
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Field Description 
Add from list Click to add a new card. 

All cards within the user's specified facility 
code, are listed. 

Add Manually Click to create new cards from the Add 
Cards window. For more information, see, 
page 54. 

Remove Click to remove the card. 

Number of 
digits Select the length of the PIN for this user. 

Code Type a PIN. 
Auto PIN Click to automatically generate a random 

PIN. 
Fingerprint Specifies if the user has recorded fingerprint 

templates. For use with the AYC-W6500 
Biometric Reader and its corresponding PC 
application. 

5.11.3. User Contact Details 

The Details tab records contact and identification details 
about the user. 
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Figure 36: User Details tab 

The Details tab contains the following fields: 

Field Description 
Telephone Type an office telephone number for the 

user. 
Mobile Type a cell phone number for the user. 
Fax Type a fax number for the user. 
Email Type an email address for the user. 
Address Type a postal address for the user. 
Home 
telephone Type a home telephone number for the user. 

Car 
registration Type the user's license plate number. 

Title Type the user's title (e.g. "Mr."). 
Employment 
Date Enter the date that the user joined the firm. 

Notes Type any additional information. 
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Field Description 
Visitor 

 
By default, the checkbox is not selected, to 
indicate that details are being set for a 
regular user.  
You can select the checkbox to enter details 
for a visitor. This opens the Visitor Properties 
window (see Figure 39), and places the new 
visitor in the tree under Visitors. 

Details Click to open the user's additional details 
folder. 

5.11.4. User Defined Data 

The User Fields tab can be used to store any information 
required by the system operator. 

 
Figure 37: User Fields tab 

User fields are defined in the Tools > Options > User 
Fields/Default tab. See User Defined Fields, page 111. 
1. Type details for the user, and click OK. 
2. Click Add User from within the User tab to add new users. 

 The window closes and the display area displays the user. 
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5.12 Defining Visitors 
AxTrax AS-525 stores contact details for each visitor, associated 
card details, and visitor access rights. 
The Visitor Properties window has four tabs: 
• General tab displays identification and control information 
• Codes/attachments tab displays information about cards 

associated with the visitor, as well as Access areas where 
the card cannot be used, and information about the 
visitor's host 

• Details tab records visitor contact details 
• User Fields tab stores user-defined data 

 

To create visitors: 
1. Expand the Departments\Visitors element, and select 

Visitors. 
2. On the toolbar, click the New icon. 

5.12.1. General Visitor Properties 

The General tab for the Visitor displays the same information as 
for a regular User: 
• Visitor identification information 
• Visitor validity settings 
• Access rights for the visitor 

See Section  5.11.1 for descriptions of these parameters. 
 

5.12.2. Associated Cards and Codes 

The Codes/Attachments tab displays: 
• The cards (up to 16 cards) and the PIN code assigned to 

this visitor. 
• Whether biometric fingerprint templates are enrolled for 

this visitor; only valid when using Rosslare’s AYC-W6500 
Biometric reader and its corresponding BioTrax PC 
application is in use. 

• The Access Area where the visitor's card is automatically 
disabled. 
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• The department and user hosting the visitor. 

 
Figure 38: Visitor Codes/Attachments tab 

The Codes/Attachments tab contains the following fields: 

Field Description 
Facility Code The site code assigned to this card. 
Card Number The unique number of this card. 
Status Select the status of the card. Inactive 

cards cannot gain access to the facility. 
Add from list Click to add a new card. 

All cards within the user's specified facility 
code, are listed. 

Add Manually Click to create new cards from the Add 
Cards window. For more information, see, 
page 54. 

Remove Click to remove the card. 

Number of 
digits Select the length of the PIN for this user. 

Code Type a PIN. 
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Field Description 
Auto PIN Click to automatically generate a random 

PIN. 
Fingerprint Specifies if the user has recorded 

fingerprint templates. For use with the AYC-
W6500 Biometric Reader and its 
corresponding PC application. 

Access Area Areas where the card is automatically 
disabled, and cannot be used to gain 
access to the facility. 

Department Select the name of the department that is 
hosting the visitor. 

User Select the name of the user who is hosting 
the visitor. 

Comments Type any comments regarding the visitor's 
host. 

 

5.12.3. Visitor Contact Details 

The Details tab records contact and identification details 
about the visitor. 

 
Figure 39: Visitor Details tab 
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The Details tab contains the following fields: 

Field Description 
Telephone Type an office telephone number for the 

visitor. 
Mobile Type a cell phone number for the visitor. 
Fax Type a fax number for the visitor. 
Email Type an email address for the visitor. 
Address Type a postal address for the visitor. 
Home 
telephone 

Type a home telephone number for the 
visitor. 

Car 
registration Type the visitor's license plate number. 

Title Type the visitor's title (e.g. "Mr."). 
Date of 
assignment 

Enter the date that the visitor received the 
assignment in the firm. 

Notes Type any additional information. 
Visitor 

 
By default, the checkbox is selected to 
indicate that details are being set for a 
visitor.  
You can clear the checkbox to enter details 
for a regular user. This opens the User 
Properties window (see Figure 36), and 
places the new user in the tree under Users. 

Visit 
Date/Time 

Enabled only if the Visitor checkbox is 
selected. 
Select the checkbox, and then select the 
date and time that the visitor arrived. 

Email Click to open the On Access Send Email 
dialog, for informing when visitor accesses 
the facility. 

Details Click to open the visitor's additional details. 

5.12.4. User Defined Data 

The User Fields tab is used to store any information required by 
the system operator. See section  5.11.4 for details on this tab. 
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5.13 Creating Access Areas and Global 
Antipassback Rules 

A large site can be divided into several smaller and more 
manageable access areas. Reports can be produced 
individually for each area. 
In addition, global Antipassback rules can be applied for each 
access area. When global Antipassback rules are in force, a 
user cannot reenter an access area until they have left it. 

 

Note: 
Global Antipassback functionality is only enforced 
when AxTrax AS-525 is connected and monitoring the 
entire access control system. 

Use the Access Area window to add entry and exit door 
readers to and from an area within the facility. 

To create a new access area: 
1. In the tree view, expand Access Area, and select the 

parent area within which to add the new access area. 
2. On the toolbar, click the New icon. 

The Access Area window opens. 

 
Figure 40: Access Area window 
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The Access Area window contains the following fields: 

Field Description 
Description Type a description for the access area. 
Enter to area Lists the entry readers into this access area. 
Exit from area Lists the exit readers out of this access area. 
< / > Click to add and remove readers from the 

Enter to Area and Exit from Area lists. 
3. Type a description for the access area and select entry 

and exit readers.  
4. Click OK. 

The window closes and new access area appears in the 
display area. 

5. In the tree view, select Global Antipassback, and then click 
the New icon  on the toolbar. 
The Global Antipassback dialog appears. 

 
Figure 41: Global Antipassback dialog box 

6. Type a description for the Antipassback rule, and select the 
access area and time zone for which it applies.  

7. Select Hard or Soft Antipassback. 
8. Click OK. 

The dialog closes and the global Antipassback rule is 
shown in the display area. 

 

Note: 
Global Antipassback causes an Antipassback event 
only on "Enter" readers to the defined "Area".  
To implement Antipassback on Exit readers as well, it 
is necessary to define a new area with opposite 
reader directions: 
Readers defined "Enter" in the first area need to be 
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defined again in the new Area as "Exit" readers, and 
"Exit" readers in the first "Area" should be defined as 
"Enter" readers in the second "Area". 

5.14 Setting Panel Links 
Panel Links are rules for how the system should behave when 
events occur in the access control panel. The Links window 
displays: 
• An event on a panel and the panel element to which the 

link response applies 
• The required input or output response 
• Any alarm message to display on the AxTrax AS-525 

computer 

To create a panel link: 
1. In the tree view, click Networks.  

The available networks are listed in the display area. 
2. Select a network and expand a panel in the tree view. 
3. Select Panel Links and select a link from the display area. 
4. Click the Edit icon.  The Links Window opens. 

 
Figure 42: Links window 
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The Links window contains the following fields: 

Field Description 
Source Type Select the panel element type which 

generates the event. 
Source Select the panel element which generates 

the event. 
Up to eight links can be added for each 
source in AC-225 and AC-525. 
Up to two links can be added for each 
source in AC-215. 

Event Select the event. 
Event 
Description Type a description for the event. 

Enabled Select the checkbox to activate this link rule. 
Generate 
Alarm 

Select the checkbox to generate an alarm 
condition and to take a popup or snapshot 
(provided that the Popup or Snapshot option 
is enabled in Options > Video Settings) when 
the selected event occurs. 

Destination 
Type 

Select the panel element type that responds 
to the event. 

Destination Select the panel element that responds to 
the event. 

Operation Select the operation for the destination 
element to perform. 

Time Enter the duration for which this operation 
should apply. This box is only available when 
a time-bound operation is selected. 

Time Zone Select the time zone during which this link 
rule applies. 

Alarm 
Message 

Type a message to be displayed as an on-
screen alarm when the selected event 
occurs. 
This box is only available when the Generate 
Alarm checkbox has been enabled. 
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Field Description 
Camera 
Available 
with AC-525 
only 

Select the camera name. 
This field appears if the Popup or Snapshot 
option is enabled in Options  Video 
Settings, and Generate Alarm checkbox is 
selected. 
This will enable the automatic video Popup 
and Snapshot features to work when this link 
condition is activated. 

Select Color Click to select a color for the alarm message. 
This box is only available when the Generate 
Alarm checkbox has been enabled. 

Sound 
check-box 

Click to select Sound for Alarm; operable 
when Generate Alarm checkbox is enabled. 

Browse Browse files for the sound *.wav file you want 
the Generated Alarm to sound. 

Sound Now 
button 

Click the Sound Now button to generate the 
selected sound. 

5.14.1. Setting PTZ Camera Presets (AC-525) 

PTZ cameras (pan tilt zoom) can be rotated, and their 
zoom/focus setting can be changed by external control. In 
addition, the cameras can be programmed to various "preset" 
points, where each preset represents a different camera 
position and zoom settings. AC-525 supports 64 preset points 
per camera. Camera presets must be programmed in 
advance in the ViTrax "PTZ control" window. 
The "change PTZ preset" commands can be sent by defining 
various parameters in the Links screen, as follows: 
1. Set Destination Type to PTZ Camera Preset. 
2. Set Destination to the name of the camera. 
3. Set Operation to Send Preset. 
4. Set PTZ Preset position to a valid amount. 
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Figure 43: PTZ Camera Preset 

5.14.2. Switching between ViTrax and Local Recording 

In the Links window, you can enable switching between "ViTrax 
recording" and "Local recording". Enabling this option means 
that when communicating with panel functions, ViTrax 
recording takes place on the ViTrax server via an AxTrax 
command. However, when the network is down and the panel 
generates a "No communication with server" event, the panel 
automatically performs "Local recording" on the USB disk on 
key.  
When communication resumes, normal "ViTrax recording" 
resumes. 
Set Destination Type to Local Recording. 
Set Destination to Camera Momentary no communication. 

 
Figure 44: Enabling switching between ViTrax and Local Recording 
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5.14.3. Using the "USB Disk Low Level" Event 

When the USB disk on key remaining capacity is too low due to 
previous recorded streams, a "USB Disk Low Level" event is 
generated. AC-525 periodically monitors its USB disk on key 
consumed memory capacity, and generates an event when 
the capacity goes below the user preset alarm threshold 
(defined in the Panel Properties window). This event can be 
defined as an alarm event for further notifications, such as 
popup windows. In addition, you can assign this event in the 
Links window to perform many other operations, such as 
activating a relay. This enables providing a warning even when 
AxTrax is offline. 
You can assign the "USB Disk Low Level" event to activate a 
relay, as follows: 
1. Set Source Type to Panel. 
2. Set Event to USB Disk Low Level. 
In addition, you can designate this event as an alarm event by 
enabling "Generate alarm". 

 

Note: 
Numerous events and links are defined in Panel Links. 
The Operators must avoid conflicts or illogical 
definitions. Not all event sources that appear in 
Panel Links are enabled in the panel, and the 
Operator should verify them. Test the Link condition 
operations after making any changes to the Link 
definitions. 

5.15 Creating Elevator Control 
Elevator control can be created by following four simple steps. 
Step One: Assign a reader to the elevator control. 

Normally, a reader is associated with a door. For elevator 
control, a selected reader should be associated with several 
outputs (floors). In the reader Properties window, clear the 
Open Door checkbox. See Setting Door Properties section on 
page 44. 
Step Two: Create output groups. 

Every output group represents a floor or several floors.  
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To create an output group, see Creating Output Groups on 
page 53. 

 

Note: 
When creating an output group for the 
elevator control, the selection only applies to 
outputs from the same panel. 

Step Three: Create panel link. 

Only one panel link is required. Figure 45 shows the Panel Link 
configuration. 

 
Figure 45: Panel Link Configuration 

Step Four: Associate users with elevator control rights. 

Each user can be associated with the relevant access group 
to allow that user access to specific floors, as needed.  
In the General tab of the User window, associate a user with 
output groups. See General User Properties, on page 57. 

5.16 Creating Status Maps 
The Status Map displays the status of every door, input, output, 
antipassback rules, and alarms in the facility on user-selected 
floor plans. 
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To set-up a Status Map: 
1. In the tree view, click Events; then, click Status Map and 

click the New Element icon. 
A new map element appears in the tree view. 

2. Right-click the new map element.  
A shortcut menu appears. 

3. Select the Picture option. 
The Select Image File Name window opens. 

 

Note: 
To change the map image and/or to add objects on 
the map, you must press the Pause key (see Toolbar, 
page 23). This enables the option to right-click the 
map name in the tree view. 

4. Select a graphic file for the Status Map background. 
The file is shown in the display area in one of the following 
formats: jpg, gif, or bmp. 

 
Figure 46: Status Map with Image 

5. Ensure that the Status Map toolbar is showing the "offline 
mode" icon. 
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Click Networks, and then right-click a door, reader, input, 
output, panel, or another status map that should be 
displayed as an object on the status map. 

6. From the shortcut menu, select Add to Map. 
The object appears on the status map, and can be 
dragged to its correct position. 

 
Figure 47: Status Map with Door 

 
7. Right-click a map object to set its properties, and select 

Show on Map from the shortcut menu. 
The Show on Map window opens. 

 
Figure 48: Show on Map window 
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8. Select the Status checkbox to display the objects state on 
the status map. 
For a door's Show on Map properties, select: 
• By Door Monitor- show the door's open state based on 

its physical position. 
• By Door Output- show the door's open state based in 

the status of its lock. 
9. Repeat step 5–7 until all objects are shown on the status 

map, as required. 
Repeats steps 1–7 to setup additional status maps. 

 

Note: 
Status map icons can also be added to other status 
maps, indicating where the two map areas meet.  

5.17 Setting Door Forced 
Door Forced occurs when a controlled door opens illegally 
when the door relay output is not activated. This may occur if 
someone opens a door without inputting a valid code or using 
a Door REX button.  
In order to detect a Door Forced condition, the door must be 
equipped with a door contact connected to the Monitor Input 
of the relevant door.  
When Door Forced is enabled, the system can generate a 
Door Forced event, which can be used to generate an alarm 
or to toggle an output.  
When the "Door forced open" or "Door held open" option is 
selected, the camera takes a popup or snapshot (provided 
that the Popup or Snapshot option is enabled in Options > 
Video Settings) when an event occurs  



How to Set Up a Site 

AS-525 AxTrax Software Installation and User Guide Page 79 
 

 
Figure 49: Door Properties 

 

To Set Door Forced 
1. On the AxTrax Tree menu, select Network>Panel>Door.  

The Door Properties window opens. 
2. Select the Door Forced Open checkbox. 
3. Enter a delay (if required) in Minutes and Seconds. Usually, 

delays are not required, since Door Forced is detected 
immediately.  
This setting allows a "Door Forced" event to generate. The 
event can then be used to generate a system alarm, or to 
activate an output. All of these possibilities are configured 
in the "Links" window. 

4. On the AxTrax Tree menu, select Network>Panel>Panel 
links> "New" command button.  
The Links window opens, followed by the Door Properties 
window. 

5. Define the location and results of the Door Forced 
conditions: 
• In Source Type and Source, select the Door on which 

Door Forced should occur. 
• In Event, select "Door Forced Open". 
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• In Destination and Destination Type, select the 
operation that Door Forced should trigger (including 
"None" if applicable). 

6. To generate an alarm condition, select the Alarm 
checkbox, and define the alarm details as described 
above. 

 
Figure 50: Door Forced Settings 

 
 

5.18 Setting Door Held Open 
"Door Held Open" is a condition where the controlled door 
remains open longer than a predefined period. This is useful for 
detecting a condition in which a door is not closed after it has 
been validly opened. The "Door Held Open" condition may 
occur if someone blocks the door for free passage.  
 
In order to detect the Door Forced condition, the door must be 
equipped with a Door contact, connected to the Monitor 
input of the relevant door.  
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When Door Held Open is enabled, the system can generate a 
Door Held Open event, which can generate an alarm or can 
toggle some output.  

 
Figure 51: Door Properties 

 

To Set Door Held Open: 
1. On the AxTrax Tree menu, select Network>Panel>Door.  

The Door Properties window opens. 
2. Select the Door Held Open checkbox. 
3. Enter the required delay in Minutes and Seconds. 

(Normally, 30 seconds is a sufficient delay.) 
4. This setting generates a "Door Held Open" event, which 

can be used to generate a system alarm, or to activate an 
output.  
These possibilities can be configured in the Links window. 

5. On the AxTrax Tree menu, select Network>Panel>Panel 
links> "New" command button.  
The Links window opens, followed by the Door Properties 
window. 

6. Define the location and results of the "Door Held Open" 
conditions: 
• In Source Type and Source, select the Door on which 

Door Held Open occurs. 
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• In Event, select "Door Held Open". 
• In Destination and Destination Type, select the 

operation that Door Held Open will trigger (including 
"None" if applicable). 

7. To generate an alarm condition, select the Alarm 
checkbox, and define the alarm details as described 
above. 

 
Figure 52: Door Held Open Settings 

 

5.19 Door Interlock 
Door Interlock, sometimes referred to as Mantrap, prevents two 
or more related doors from opening at the same time. It may 
be useful for the entry holes of Clean Rooms, or in other 
facilities with two exit doors. It should only be possible to open 
one door at a time with a valid user code.  
AxTrax features a dedicated mechanism to define Interlock for 
two, three, or four doors, provided that they are located on 
the same access control panel. Interlock cannot be used in 
panels that support a single door.  
To enable Interlock, related doors must be equipped with a 
door position sensor, connected to the Door Monitor input of 
the relevant doors. Door Interlock only restricts user entry 
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through readers or keypads. The use of a REX button or Links 
settings should not be used to activate doors, which are not 
limited by Interlock.  
Doors are considered open when either the Door Monitor or 
the Door Relay is opened, and it should not be possible to 
open any other related door with user codes. If an attempt is 
made to open another door, an "Access denied-Door 
interlock" event is generated.  
 

Setting Door Interlock 
In a typical Interlock application with a 2Doors/4Reader panel 
controlling entry and exit to a restricted area, the doors and 
readers may be located as follows: 
• Door1/Reader1 - Entry from outside into Man Trap room 
• Door1/Reader2 – Exit from Man Trap room to outside 
• Door2/Reader3 - Entry from Man Trap room into restricted 

area 
• Door2/Reader4 – Exit from restricted area into Man Trap 

room 
 

 
Figure 53: Door Interlock Diagram 
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To set the AxTrax Door Interlock Setting: 
1. Edit Panel screen >> Options tab.  
2. In Door Interlock, select the Enabled checkbox. 
3. Select at least two door checkboxes. 
 

 
Figure 54: Setting Door Interlock 
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6. ViTrax Video Integration 
Utilizing cameras on your AC-525 panel is done using the 
following Steps: 

Step Action Section 

 
Connecting to 
ViTrax Server 

See Connecting to ViTrax Server, 
page 85.  

 
Adding a Camera 
to AC-525 panel 

Adding a Camera to AC-525 
panel, page 85. 

 
Using Panel Links See Setting Panel Links, page 70. 

 
Viewing Recorded 
Events 

See Viewing Recorded events, 
page 89. 

6.1 Connecting to ViTrax Server 
Define the ViTrax Server database with which the AS-525 AxTrax 
Software communicates. 

To Connect to ViTrax Server: 
1. When the ViTrax Server is running, click File/ViTrax Server. 

The ViTrax Servers window is displayed. 

 
Figure 55: ViTrax Servers 

2. On the toolbar, click the New icon. 
The Server ViTrax window is displayed  

New 

Edit 
Delete 
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Figure 56: Server ViTrax window 

3. In ViTrax IP Address, type either localhost or another IP 
address name.  

4. In ViTrax User Name, type the username. 
5. In ViTrax Password, type the password. 

 

Note: 
The typed Password must resemble the non-default 
password for the server. 

6. Select the Auto connect on Start checkbox. 
7. Click Connect. 
8. Click OK. 

A "Server Vitrax Connecting" message appears in the 
Axtrax status bar while Axtrax attempts to connect to the 
Vitrax Server. When connected, the message box “ViTrax 
Server connected” is displayed. The ViTrax server now 
appears in the ViTrax Servers window list (see Figure 55). 

 
Figure 57: ViTrax Servers list 
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6.2 Adding a Camera to AC-525 panel 
Defining communication of AC-525 cameras to the ViTrax 
Server, is done physically between the camera and the AC-
525 panel (see AC-525 Installation Manual). 
The cameras available on this network are displayed when 
clicking the Network in the tree. When clicking the icon, the 
camera list is displayed. Expand the tree to see which cameras 
are connected to which panels. See also  Appendix D Cross 
Platform Camera Setup, on page 130. 
 

To configure a camera to the network: 
1. Configure the Network as seen in Section  5.2. 
2. Once the camera is physically installed, the system reads 

the camera on the network and displays it in the tree. 
 

To view the camera list: 
1. In the toolbar, click the Camera icon. 

The Camera list window is displayed. 

 
Figure 58: Cameras List window 
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6.3 Conditioned Recording via Panel Links 
You can select the source, destination, and period of 
recordings using Conditioned Recording sequences 
programmed via the Panel Links screen.  
 

To create a panel link: 
1. In the tree view, click Networks.  

The available networks are listed in the display area. 
2. Select a network, and expand a panel in the tree view. 
3. Select Panel Links and select a link from the display area. 
4. Click the Edit icon. 

The Links Window opens. 

 
Figure 59: Local Recording  

5. In the Destination Type drop-down list, select Local 
recording.  

6. In the Destination drop-down list, select a camera: 
momentary recording or pre-event recording, and then 
click OK. 
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6.4 Viewing Recorded events 
In the Camera Properties window, you can view live streaming 
and edit various camera properties. 

To view Recorded Events: 
1. Double-Click Recording Started from either 

EventsArchive, or EventsPanel 
 

To access Camera Properties: 
1. In the tree view, double-click Camera <name>.  

The Camera Properties window is displayed. 

 
Figure 60: Camera Properties window 

The Camera Properties window includes the following: 

Field Description 
Description Displays the camera name. 
Enable ViTrax 
Motion 
Detector 

Select this checkbox to enable motion 
detection in ViTrax. Enabling motion 
detector, enables Record Motion features. 
It is possible to get motion detection events 
from ViTrax, and use them to initiate 
recording, by first setting the Motion 
Detection section on this window, and then 
set ting motion detection properties in ViTrax, 
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Field Description 
in the Sensitivity, Exclusion, Format, and 
Source tabs.  

Time Lapse This checkbox is automatically enabled due 
to the camera recording settings. Time Lapse 
means the recording of single frames 
periodically. AxTrax automatically enables 
the Time Lapse option in ViTrax, when setting 
recording by AxTrax.  

Frame rate Select the Time Lapse period. By default, the 
Time Lapse period is set to 0.005 frames per 
second (1 frame every 200 seconds) 

Live Audio 
Volume Select the live audio volume. 

Audio to 
Camera 

Select the checkbox to indicate that a 
microphone is connected to the camera. 

Microphone 
Device 

Enabled when the Audio to Camera 
checkbox is selected. 
From the drop-down list, select a 
microphone. 

Properties Camera hardware properties. 
PC Archive Streams saved in the PC. 
Local Archive Streams saved in the USB-key. 
Snapshot 
Archive Opens the images list stored to that camera.  

Four buttons Recording start, Recording stop, Audio to 
camera, and Save current snapshot. 

2. Click OK. 
 

 

Note: 
ViTrax Server must be running to view recordings. 

 

For more information on camera properties, see ViTrax 
Software Manual. 
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To access Live Video: 
1. In the tree view, right-click Camera <name>.  
2. In the right-click menu, select View. 

The Live Video Streaming window is displayed. 

 
Figure 61: Live Video Streaming 

The Live Video Streaming window includes the following 
buttons: 

Icon Name Click icon to… 

 
Recording Save streams to the archive (see 

Saving streams to archive, page 23). 

 Start Start Recording to the archive. 

 Stop Stop Recording to the archive. 

 
Save current 
snapshot 

Save the current snapshot. 

3. Click Cancel to close. 
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7. Manual Operation 
In addition to AxTrax AS-525's automated monitoring and 
control of the access control network, it is also possible to 
control the network directly. 

7.1 Controlling the Door Manually 
The Door Manual Operation window allows an operator to 
open or close a selected group of doors directly. 

To manually open or close a door: 
1. On the toolbar, click the Open Door Manually icon. 

The Door Manual Operation window opens. 

 
Figure 62: Door Manual Operation window 

The operator can sort the listed panels/doors in regular or 
reverse order, by clicking the column header with the left 
mouse button.  

2. Select an option: 
• Open momentarily - All selected doors are opened for 

the time set in the timer box. 
• Open permanently - All selected doors are opened. 
• Close output - Close the selected doors and return 

control to AxTrax AS-525. 
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3. Select the checkboxes of those doors to which to apply 
the operation. 
Click Apply to perform the operation. 

 

Note: 
Door Manual Operation can only control doors that 
have been set as Manual Door Open Enabled in the 
Door Properties window.  
See Setting Door Properties, page 44. 

7.2 Changing the Reader Mode 
The Manual Reader Operations window allows an operator to 
change the operation mode of a reader. 
Readers have six possible operation modes: 
• Inactive: The reader is not in use. 
• Card Only: The reader accepts cards only. 
• PIN Only: The reader accepts PIN inputs only. 
• Card or PIN: The reader accepts both cards and PINs. 
• Desktop: The reader is inactive, but can record new cards 

for the AxTrax AS-525 database. 
• Secure (Card + PIN): The reader requires first a card and 

then a PIN. The PIN must be entered within 10 seconds of 
the card. 

• No Access: The reader will not grant access to users. 
 

To manually change the reader mode: 
1. In the tree view, expand the Networks element, and then 

expand a selected network. 
2. In the tree view, select a panel, and then click the Change 

Reader Mode icon.  
The Manual Reader Operations window opens. 
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Figure 63: Manual Reader Operations Window 

2. Select an option: 
• Change operation mode permanently - Resets all selected 

readers to the selected operation mode. 
• Change operation mode until Card+PIN starts - Resets all 

selected readers to the selected operation mode until 
they enter a secured time zone.  
In the secured time zone, the operation mode switches to 
Card + PIN. 

• Default- Returns control of the readers to the system. 
3. Select the checkboxes of those readers to which to apply 

the operation. 
Click Apply to perform the operation. 

 

Note: 
For more information on secured (Card + PIN) time zones, see 
General Reader Operation Settings, page 47. 

7.3 Controlling Outputs Manually 
The Manual Output Operation window allows an operator to 
open or close a selected group of outputs on a panel directly. 

To manually open or close an output: 
1. In the tree view, expand the Networks element ,and 

expand a selected network. 
2. In the tree view, select a panel,, and then click the  

Change Output Operation icon. 
 The Manual Output Operation window appears. 
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Figure 64: Manual Output Operation window 

3. Select an option: 
• Open momentarily - Opens all selected outputs for the 

time set in the timer box. 
• Open permanently - Opens all selected outputs. 
• Close output and return to default mode - Closes the 

selected outputs and returns control to AxTrax AS-525. 
4. Select the checkboxes of the outputs to which to apply the 

operation. 
5. Click Apply to perform the operation. 

7.4 Manually Disarming Inputs 
The Manual Input Operation window allows an operator to 
disarm a selected group of inputs directly on a panel. 
Armed input means input is active; disarmed input is inactive 
and does not trigger any operation or alarms. 

To manually disarm or rearm an input: 
1. In the tree view, expand the Networks element and 

expand a selected network.  
2. Select a panel in the tree view, and click the Change Input 

Operation icon. 
The Manual Input Operation window is displayed. 
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Figure 65: Manual Input Operation window 

3. Select an option: 
• Input permanently disarmed- Deactivates all selected 

inputs. 
• Arm input and return to default mode - Reactivates the 

selected inputs, and returns control to AxTrax AS-525. 
4. Select the checkboxes of the inputs to which the operation 

is to be applied. 
Click Apply to perform the operation. 

 

7.5 Testing the Siren 
The Manual Siren Operation window allows an operator to test 
the siren for a selected panel. 

To test the siren: 
1. In the tree view, expand the Networks element, and 

expand a selected network. 
2. Select a panel in the tree view, and then click the Siren 

Operation icon. 
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Figure 66: Manual Siren Operations window 

3. Select an option: 
• Open momentarily - Sounds the siren for the time set in 

the timer box. 
• Close siren and return to default mode - Silences the 

siren and returns control to AxTrax AS-525. 
4. Click Apply to perform the operation. 
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8. Reports 
AxTrax AS-525 supports two types of reports.  
Immediate reports list details of recent movements (within the 
last few hours). They are shown in the display area, and can be 
exported. 
Archive reports are immediately exported. 
 

8.1 Immediate Reports 
There are four types of immediate reports: 
• Who's been in today - Lists where and at what time each 

user was granted access for the first time today. 
• Last known Position - Lists where and at what time today 

each user was most recently granted access. 
• Roll-Call Readers - Lists the last time each reader was 

accessed, and by whom, within the last 1–99 hours. 
• Roll-Call Areas - Lists all users currently within the selected 

area, sorted by department and entry time. The report lists 
all personnel who entered the facility within the last 1–99 
hours. 

To show an immediate report, select it from the Reports 
element of the tree-view, under Immediate. 
 

To create a new immediate report: 
1. Expand the Reports element, and select Immediate from 

the tree view. 
2. On the toolbar, click the New icon. 

The Immediate Reports Wizard opens. 
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Figure 67: Immediate Reports Wizard (Step 1) 

3. Select a report type, and then click Next. 
Follow the on-screen wizard instructions until the wizard has 
completed. The display area lists the new report. 

 

8.2 Archive Reports 
You can produce three types of reports: 
• Panels event reports 
• System AxTrax events reports 
• Interactive reports 

 

8.2.1. Panels events reports  

Panel event reports displays details of all recorded panel 
events.  
There are six available panel event reports. 
• Attendance report - Lists the attendance hours for selected 

users, sorted by date. Results include hours present, time in, 
and time out. 

• Panels report - Lists all the events recorded by the selected 
panels, sorted by date. 
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• Access report - Lists all access events recorded by the 
selected readers, sorted by reader and date. 

• Areas report - Lists all users within selected access areas, 
sorted by department and date. 

• Readers report - Lists all users who have accessed the 
selected readers, sorted by department and date. 

• Fingerprint report – Lists fingerprints of all users. 
• Visitors report - Lists visitors who have made a visit to a 

certain user or department, or lists all related visitors. 
 

8.2.2. System AxTrax events report 

 System AxTrax events reports list details of system and operator 
activity.  
There are three available panel event reports. 
• System report - Lists all operations performed by the AxTrax 

server, sorted by date. 
• Operators report - Lists all the operations performed by 

registered system operators, sorted by operation event 
type and date. 

• Alarms and Antipassback handler report - Lists all raised 
system alarms, sorted by operator and date. 

 

8.2.3. Interactive report 

Interactive reports list details of users and their access activity. 
• User details - Lists selected users' details, including assigned 

cards, PIN, and assigned access group. 
• Visitor details - Lists selected visitors' details, including 

assigned cards, PIN, and assigned access group. 
• User access rights - Lists site access details for selected 

users, with full details of readers accessed and in which 
time zones. 

• Not responding users - Lists users for whom there have 
been no access events for a selected period of time. 
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9. Administrator Operations 

9.1 Setting the Time and Date 
Select panels by network, and reset their date and time to the 
AxTrax server's system date and time, using the Set Time 
window. 

To reset the panel time: 
1. In the tree view, expand the Networks element, and select 

a network. 
2. Click the Set Time icon. 

The Set Time window opens. 

 
Figure 68: Set Time window 

3. Select the panels to reset, and then click the Apply button. 
The server connects to the panels and sets the time as 
requested. A dialog confirms the operation. 

9.2 Detecting Panels Automatically 
It is possible to search for panels over the access control 
network. This is useful during installations; AxTrax AS-525 finds all 
connected panels in the network and checks them. Panels 
can then be quickly activated and updated. 
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To detect panels: 
1. In the tree view, expand the Networks element, and select 

a network. 
2. Click the Find Panels icon. 

The Find Panels window opens. 

 
Figure 69: Find Panels window 

3. Select the panels that should be activated. 
Click the Apply button to activate the panels and 
download setup information.  
Once the detection process is complete (may take 2-3 
minutes), the display shows all of the detected panels and 
their corresponding information.  
The selected panels are then automatically appended in 
the tree view under current network. 

9.3 Manual Download of Panel Data 
Operators can manually download specific access-control 
panel configurations using the Download Data window. All of 
the panel’s data is downloaded with no data parsing or 
filtering. 

To manually download panel data:  
1. In the tree view, expand the Networks element, and 

expand a selected network. 
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2. In the tree view, select a panel, and click the Download 
Data icon. The Download Data window opens. 

 
Figure 70: Download Data window 

3. Click the Apply button to apply the operations. 

9.4 Downloading Failed Data 
In the event that some data fails to download into the access 
control panels, it is possible to perform a download of the 
failed operations only. This operation can be performed on a 
single panel, on all the panels in a network, or on all the panels 
in the entire system. 

To download failed data: 
1. In the tree view, select a specific panel, a specific Network, 

or all the Networks. 
2. Select and click the Download Failed Data icon. 

The Download Data icon window opens. 
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Figure 71: Download Data icon window 

3. Select the required parameters to download, by selecting 
the checkbox next to each parameter; you can use the 
Select All and Select none buttons for fast selection.  
Click the Enable Selected or Disable Selected button to 
apply the status to the selected parameters. 

9.5 Testing User Counters 
When using User Counters, It is possible to view the current User 
count value in each panel that has a Reader designated with 
the "Deduct User" option. 
 

To view User Counters: 
1. In the tree view, select Department\Users; then, select one 

User in the Display area. 
2. Select and click the User Counter icon. 

The Request User Count window opens. 
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Figure 72: Request User Count window 

3. Click Test to read a User Counter in each of the panels. 

9.6 Maintaining the Database 
The system database is maintained from the Database 
window. 

 

Note: 
This option is only available within the AxTrax Server 
system. 

 

To open the Database window: 
• From the menu bar, select Tools > Database. 

 
Figure 73: Database window 
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The following database operations are available: 

Operation Description 
Periodic Backup Run a scheduled backup every specified 

number of days at the specified time. 
Backup now Run a one-time backup immediately. 
Export 
Configurations 
and Events 

Copy the contents of the database to the 
selected folder. 

Import 
Configurations 

Replace the current configuration based 
on the imported file. 

Import 
Configurations 
and Events 

Replace the current configuration and 
events based on the imported file. 

Erase 
Configuration 
and Events 

Erase the current database configuration 
and all events. 

Import earlier 
database 
versions from  
AS-215  

Replace the current database. 
Only VeriTrax AS-215 databases from 
versions 0.5–2.02.04 and 2.05.00–2.05.05 or 
newer can be migrated.  

Import earlier 
database 
versions from 
VeriTrax AS-225 
/ AxTrax AS-525   

Replace the current database. 
VeriTrax AS-225 or AxTrax AS-525 
databases from versions 0.00.04 or newer 
can be migrated. Note that this option 
does not allow importing a database from 
a current AxTrax AS-525 version. 

Limit panel 
Events period 

Automatically erase events when they are 
older than a specified number of days. 
Before using this option, Rosslare 
recommends that you set a periodic 
backup. 

Erase panel 
Events 

Erase all events that are older than a 
specified number of days. 

 

 

Note: 
The Backup and Export functions add the “_VeriTrax_vX” prefix 
at the end of exported or backed-up database. The Import 
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database function will execute only with the string at the end of 
the file name. After a database has been imported, the panel 
status may change to disabled. If this is the case, the operator 
should re-enable the panels. 

 

9.7 AxTrax Options and Preferences 
AxTrax AS-525 can be customized to meet the preferences of 
the operator using the Options window. 

To open the Options window: 
• From the menu bar, select Tools > Options. 

The Options window has five tabs: 
• General startup, presentation and connection preferences 
• Settings to control AxTrax information pop-ups 
• Settings to configure AxTrax video settings 
• Additional user-defined fields for the User Properties 

window 
• Report title settings 

9.7.1. Startup, Presentation, and Connection Options 

The General tab includes basic control over AxTrax AS-525 
startup and security options, user highlighting preferences, and 
transaction connection settings. 

 
Figure 74: General tab 
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The General tab contains the following fields: 

Field Description 
Auto startup Select the checkbox to start AxTrax AS-525 

automatically whenever the computer is 
turned on. 

Language Select the system interface language. This 
option temporarily switches the language 
until you close AxTrax AS-525. Permanent 
language settings are set under Operators 
options. 

Outlook Select the checkbox to load Microsoft 
Outlook™ holidays into AxTrax AS-525. 

Select Holiday Click the button to select Microsoft 
Outlook™ holidays to load into AxTrax AS-
525. 
This button is only available when the 
Outlook checkbox has been enabled. 

Show download 
succeed 

Select the checkbox to add a message to 
the event history upon successful system 
parameters download from the AxTrax AS-
525 software to the panel. 

Use highlight 
user events 

Select the checkbox to display selected 
user information in a colored highlight. 

Selected user / 
All users 

Select one of the checkboxes to highlight 
either selected users or all users. 
When Selected User is enabled, users are 
highlighted provided that they have been 
marked for highlighting in the User 
Properties window.  
See General User Properties, page 57. 

Unknown key Select this checkbox to highlight every 
record of attempted access by an 
unknown card or PIN. 

Use highlight 
alarm events 

Select the checkbox to highlight selected 
alarm events. 
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Field Description 
Selected alarms 
/ All alarms 

Select one of the checkboxes to highlight 
either selected or all alarms. 
Alarms are selected provided that they 
been marked for highlighting in the Panel 
Links window. 
If All Alarms is selected, all alarms are 
highlighted. 
See Setting Panel Links, page 69. 

Use highlight 
Network and 
Panels 
 

This option can be used to quickly identify 
panels that are not responding, or 
networks which include panels that are 
not responding.  
When selecting the root "Networks" tree 
view, Networks with panels that are not 
responding are highlighted in the display 
area with the selected color. 
When selecting a specific Network in the 
tree view, panels that are not responding 
are highlighted in the display area with 
the selected color. 
Panels that are currently disabled, are not 
considered as "not responding". 

Select color Click to select a color for highlighting. 

9.7.2. Popup Options 

The Popup/Shared tab controls the behavior of popup Event 
alarms in the system. 



Administrator Operations 

AS-525 AxTrax Software Installation and User Guide Page 110 
 

 
Figure 75: Pop-Up/Shared tab 

The Popup/Shared tab contains the following fields: 

Field Description 
Enable popup 
alarm window 

Select this checkbox to activate popup 
alarm notifications. 

Access Granted Select this checkbox to display a popup 
notification whenever a reader grants 
access to a user. This option is only 
available from the AxTrax server. 

Access Denied Select this checkbox to display a popup 
notification whenever a reader denies 
access to a user. This option is only 
available from the AxTrax server. 

Access 
Recorded 

Select this checkbox to display a popup 
notification whenever an “access 
recorded” event occurs.  
This option is only available from the 
AxTrax server. 

Closed by  Select Manual to close display pop ups 
manually; select Timer, to close display 
pop ups after a set duration. 
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Field Description 
Display Window Use to determine which of the User’s 

windows to pop up: Standard user window 
or Large picture.  

HASP Key Select this checkbox if the system consists 
of less than 64 panels and you require the 
operation of the installed VeriTime 
attendance software. This is possible by 
checking if the VeriTime option is selected 
in the HASP key. 

Time Keeper Select this option to share the database 
with TimeKeeper. 

 

9.7.3. Video Settings 

The Video Settings tab is used for setting Popup, Snapshot, and 
related options, such as Video Verification. 
A Snapshot is a single frame that is captured from live video 
and stored as a compressed picture file (JPG file). Snapshots 
can be taken automatically by the system, or manually by the 
operator. When taken automatically, they can be stored in the 
snapshot archive for later inspection. An operator can capture 
a snapshot manually, by clicking the snapshot icon at the 
bottom of live video windows. This manually taken snapshot 
can be stored in a file. In addition, it is possible for the snapshot 
picture to open up automatically (Popup option). 
Popup means that a live video window may be opened 
automatically by various events in the system.  
The Video Verification option is based on both the Snapshot 
and Popup options. Whenever a known User ID is presented, 
two windows open up simultaneously – a snapshot from live 
video, and the static User picture stored in the AxTrax 
database. This allows the system operator to visually verify that 
the User who enters through the door is the User whose picture 
is stored in the database. 
Snapshot options, popup reasons, and the setting of Video 
Verification are all defined in the Video Settings window. 
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Note: 
All options in the Video Settings window are only 
supported in AxTrax Server. They are not supported in 
AxTrax Client. 

 

  
Figure 76: Video Settings tab 

The Video Settings tab contains the following fields: 

Field Description 
Operation Select the operation to perform: Pop up 

Live video window, Save Snapshot to 
archive, or Show Snapshot and save to 
archive. Selecting an operation is 
enabled only after you select an option 
in at least one of the Source Events. 

Close window 
manually / Close 
window by timer 

Select Close window manually to close a 
live video popup window or snapshot 
popup window manually. Select Close 
window by timer to close a live video 
popup window or snapshot popup 
window after a predefined amount of 
time; selecting this option enables you to 
select the time. 

Source Events Select the events that will cause popup 
or snapshot. These events are grouped 
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Field Description 
into several types: Access Events, Door 
Warning Events, Alarm Events, and ViTrax 
Events. 

Access 
Granted/Access 
Denied / Access 
Recorded 

Select the reader access events that will 
trigger the popup or snapshot 
notification. 
 

Select Access Granted to trigger the 
notification whenever a reader grants a 
user access. 
 

Select Access Denied to trigger the 
notification whenever a reader denies a 
user access. 
 

Select Access Recorded to trigger the 
notification whenever a user's access is 
recorded, and an “access recorded” 
event occurs.  
 

In addition to this setting, you also have 
to select which readers will trigger popup 
or snapshot, as well as the source 
camera. You can set these options in 
Readers >> Options window >> Popup 
and Snapshot. 

Pop up user 
picture 

Select this option to perform Video 
Verification. This option pops up the static 
User picture stored in User properties in 
the User photo field. Selecting this option 
pops up two windows simultaneously.  

Door Warning 
events 

Select this option so that either Door 
Forced or Door Held Open events cause 
popup or snapshot. Select the camera 
name in Doors properties >> Popup and 
Snapshot, to activate this option. 

Alarms Select this option to activate a popup or 
snapshot when any event defined as an 
alarm event in the Links window, occurs. 
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Field Description 
In addition, select the camera name in 
Links >> Alarm Handler to activate this 
option. 

ViTrax 
recording/Motion 
detected 

Select which events sent from the ViTrax 
server will activate popup or snapshot:  
ViTrax recording – to pop up a live 
window when ViTrax recording begins.  
or  
Motion detected – to pop up a live 
window when motion is detected. 
Note: Local recording does not support 
popup options. 

 

9.7.4. User Defined Fields 

The User Fields/Default tab controls the fields on the User Fields 
tab of the User Properties window and the Valid Data default 
value. See User Defined Data, page 63. 

 
Figure 77: User Fields/Default Tab 
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The Options tab contains the following fields: 

Field Description 
Field description Type a name for the new field. 
Field type Select the type of field. 
Add Click to add this field. 
Remove Click to delete the selected field. 
Default valid 
time 

Default time for user access rights to begin 
and end. This field is only available when 
the checkbox is selected. 

9.7.5. Report Title Settings 

The Report title tab controls basic presentation preferences for 
the reports generated by AxTrax AS-525. 

 
Figure 78: Report Title tab 

The Report title tab contains the following fields: 

Field Description 
Company 
Name 

Type the company name to be shown on 
reports. 

Font Click to set a font and color for the company 
name. 
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Field Description 
Company 
details Type the company address. 

Show report 
title 

Select the checkbox to display this company 
name and logo on the reports. 

Logo 
Add/Clear 

Click to select a logo to be printed on 
reports. 
If a logo has already been selected, click to 
remove it. 

 

9.8 Importing/Exporting User Data 
The Import/Export Data window makes it possible to 
import/export user information into/from the AxTrax database 
from/to a standard spreadsheet file. 

 
Figure 79: Import/Export Data 
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The Import/Export Data window contains the following fields: 

Field Description 
Import/Export 
Users Properties 
from external 
file/AxTrax into 
AxTrax AS-
525/external file 

Select whether to perform Import or Export 
of User properties. 

Data Type Select the type of data to import. 
Location Select the location of the file to import. 
Browse Click to select the file to import. 
Excel File 
Columns 

Select the checkboxes of the columns to 
be imported. 
Data in each column (A—M) will be 
imported as listed. 

Excel file Row Enter the first row of user data in the 
spreadsheet. 

User number 
started from 

Enter the number from which to start 
assigning unique system user numbers. 

Import 
Departments? 

Select Yes to import new departments 
into the AxTrax database. 
Select No to import users without their 
departments. 

Department Select the department to assign to the 
imported users. 
This box is only active when the Yes button 
is selected. 

Import Access 
Groups? 

Select Yes to import new access groups 
into the AxTrax database. 
Select No to import users without their 
access groups. 

Access Groups Select the access group to assign to the 
imported users. 
This box is only active when the Yes button 
is selected. 
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Appendix A. Firewall Configuration 
The following instructions explain how to configure the 
standard Windows Firewall for Windows XP. 

To configure the firewall: 
1. On your desktop, click the My Computer icon. 

The My Computer folder opens. 
2. Select the Address Bar and type "Control Panel". Hit the 

Enter key. 
The Windows Control Panel opens. 

 
Figure 80: Windows Control Panel 

3. Click the Security Center category. 
When in "Classic View", in the top-left Control Panel 
preferences pane, click Switch to Category View, and click 
the Security Center category. 
The Windows Security Center opens. 

 
Figure 81: Windows Security Center 
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4. Click Windows Firewall. 
The Windows Firewall opens. 

5. Select the Exceptions tab. 

 
Figure 82: Windows Firewall 

6. Click Add Program. 
The Add a Program dialog appears. 

 
Figure 83: Add a Program to the Firewall List 

7. Click Browse. 
The Browse dialog appears. 

8. In the File Name box, type:  
"C:\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL\BINN\sqlservr.exe". 

9. Hit Enter. 
The sqlservr program appears in the Add a Program dialog. 
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10. Select the program, and then click OK. 
The sqlservr program appears on the Windows Firewall list of 
exceptions. 

11. Repeat steps 5 and 6. In the File Name box, type:  
"C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe". 

12. Hit Enter. 
The sqlbrowser program appears in the Add a Program 
dialog. 

13. Select the program, and then click OK. 
The sqlbrowser program appears on the Windows Firewall 
list of exceptions. 

14. Click OK. 
15. Repeat steps 1 and 2. 

The Control Panel window opens. 
16. Click the Performance and Maintenance category. 

When in "Classic View", in the top-left Control Panel 
preferences pane, click Switch to Category View, and then 
click the Performance and Maintenance category. 
The Performance and Maintenance window opens. 

 
Figure 84: Performance and Maintenance window 

17. Click Administrative Tools. 
The Administrative Tools window opens. 
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Figure 85: Administrative Tools window 

18. Double-click the Services icon.  
The Services Console opens. 

 
Figure 86: Services Console 

19. Right-click Windows Firewall/Internet Connection Sharing 
(ICS). Fom the pop-up menu, click Restart. 

20. Right-click SQL Server. Fom the pop-up menu, click Restart. 
21. Right-click SQL Server Browser. Click Restart from the pop-

up menu.  
The Firewall is now configured for AxTrax AS-525. 
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Appendix B. SQL Service Settings 
In order to reach the SQL Service Settings, click on the 
following path from the Control Panel in Windows XP: 

Control Panel > Administrative Tools > Services and Applications > Services 
> SQL Server (VERITRAX). 

Double click "SQL Service (VERITRAX)" the following dialog 
opens: 

 
Figure 87: SQL Service Settings 

Under the General tab, verify that the Startup type is 
“Automatic” and that the Service status is “Started”.  

 
Figure 88: SQL Service Log On 

In the Log On tab, verify that the Local System Account radio 
button is selected. If not, select Local System Account and 
restart the computer for the changes to take effect. 
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Appendix C. Network Configuration 
The AxTrax Server connects to access control units by a serial 
connection, a TCP/IP connection, or a Modem-to-Modem 
connection.  
To connect access control panels to AxTrax AS-525 over a 
TCP/IP LAN (Local Area Network) or WAN (Wide Area Network), 
the use of a TCP/IP to Serial converter is required, unless the 
panel has an onboard TCP-IP connection (AC-225IP or AC-
525).  
Each TCP-IP connection can support up to 32 access control 
panels that are connected to each other using RS-485.  
The hardware used to connect to the TCP-IP network may be 
the MD-N32, which is a Serial to Ethernet converter, or using the 
onboard converter of AC-225IP or AC-525.  
You can also use Rosslare’s MD-N33 modem for a Modem-to-
Modem connection. Refer to the hardware installation 
manuals of the desired panel for more details. 
TCP/IP and Modem-to-Modem connections must be 
configured for use, and require expert knowledge of the local 
network. 
 

To configure TCP-IP Connection for AxTrax AS-525: 
1. In the tree view, click Networks. On the toolbar, click the 

Edit icon. The Networks window opens. 
2. Set the Network type as TCP/IP. 

3. Click the Configuration button.  
The TCP/IP Configuration window opens. 

 

Note: 
If you want to work with Remote, in the TCP/IP 
Network window select Remote (WAN), and add the 
WAN IP Address of the PC. 
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Figure 89: TCP/IP Configuration window 

The upper left window lists all TCP/IP converters attached 
on the local network, identified by their MAC address, and 
indicates if they are available to be assigned to a new 
panel network or are already assigned. 

4. From the MD-N32 list (the MD-N32's MAC address should be 
labeled on the TCP/IP converter), select the appropriate 
MAC address. 

5. In Gateway Type, select the type of TCP/IP converter, MD-
N32, MD-IP32 On board, or any other valid option. Skip this 
selection if it is already valid.  

6. Type the Local IP address and Subnet for the computer's 
network.  

7. Enter the Local Port number and select the Speed of your 
connection. It is recommended to select a higher value 
port number (4001 or higher). Note that the selected should 
not end with zeros (prefer setting Port value of 4243 rather 
than 4200). This will avoid colliding with port addresses 
reserved for various equipment installed on the same 
network. 

8. Click OK to start the verification process. 
9. Click OK twice and verify that the AxTrax AS-525 software 

accepted the configuration. 
10. Turn off the MD-N32 power (or panel power if using the 

onboard module, such as MD-IP32), and then turn the 
power on again. This step is necessary when using certain 
versions of MD-N32 or MD-IP32 models. Skip this step if not 
applicable.  
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11. If configuration applies to a WAN network, disconnect the 
configured unit from the local network, and reconnect to 
the WAN network and access control panels network 
working over the WAN. 

 

To configure MD-N33 in AxTrax: 
1. In the AxTrax software, add a new network. 
2. Under network type, select Modem.  

 
Figure 90: AxTrax AS-525 Modem Network 

 

To initialize and configure the computer modem: 
1. In the Network window, click the Configuration button.  

The Modem Configuration window opens. 

 
Figure 91: AxTrax AS-525 Computer Modem Configuration 

2. In the Dialing area, under Remote modem phone number, 
type the destination telephone number to call. 

 

Note: 
Communication speed is limited to 9600, 19200, 
57600, or 115200 bits per second. 
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3. Click to change the Number of dial attempts (if required). 
For most applications, the default dialing string is sufficient. 
The dialing string is displayed in the window. 

4. Clear the Use default checkbox. This allows adding or 
editing of the dialing string. Then, type the AT command in 
the Dialing string window.  

5. From the Dialing schedule dropdown list, select the time 
zone. 

6. Choose the disconnecting condition: Disconnect by 
schedule end or Disconnect on upload complete. 
This option is enabled when the selected time zone is 
different from the default time zone (Always and Never). 

7. In the Settings area, the initialization string is displayed in 
the window. For most applications, the default initialization 
string is sufficient. 

8. Clear the Use default checkbox to allow adding or editing 
of the dialing string. Then, type the AT command in the 
Dialing string window. 

9. Connect the computer's modem to the PC via the 
selected COM port, and click Apply to initialize the PC 
modem. 

10. Click OK to complete the initialization. 
11. If the computer displays a failure message, check the 

modem connections and repeat the last steps. 
 

 

To initialize and configure the remote modem: 
1. In the Modem Configuration window, click the Remote 

modem tab. 

 

Note: 
Remote modem initialization is at the PC side. When 
modem initialization fails through telephone line, a 
message appears. 
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Figure 92: AxTrax AS-525 Remote Modem Configuration 

2. In the Settings area, the initialization string is displayed in 
the window. For most applications, the default initialization 
string of AS-525 is sufficient. 

3. Clear the Use default checkbox to allow adding or editing 
of the dialing string. Then type the AT command in the 
Dialing string window.    

4. In Number of rings to answer, set the number of rings before 
the computer modem answers. 

5. Connect the remote modem to the computer via the 
selected com port, and click Apply to initialize the 
computer modem. 

6. Click OK to initialize. 
7. If a failure message appears, check the modem 

connections and repeat the last steps. 
 

 

The MD-N33 and AxTrax AS-525 software are now 
configured and ready. 

 
You can now continue working using the AxTrax Adding New 
Panel procedure. 
 

 

Note: 
You must perform the action twice at the PC side, to 
Initialize two MD-N33s. 
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To check the remote modem status: 
1. When a panel is setting in a modem network, you can see 

the status of the modem by clicking the phone icon in the 
toolbar. 

2. There is a manual option to dial or disconnect the modem. 

 
Figure 93: AxTrax AS-525 Modem Status 

3. In order to prevent access to AxTrax data from non-
authorized users, the AC-215, AC-225, or AC-525 access 
control panels contain a password that can be changed 
only when the modem is connected and there is a link with 
the panel. 

 

Note: 
The default password for the modem configuration 
and status screens is VeriTrax.  

You may be asked to enter the password during first data 
configuration, such as adding a new panel or 
downloading a new firmware. 

 
Figure 94: AxTrax AS-525 Modem Security 
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Restoring Factory Default Settings 

If the modem configuration password is lost or forgotten, reset 
the access control panel to the factory default settings, and 
use the default "VeriTrax" password. 

 

Caution: 
Restoring factory default settings resets all doors and 
reader configurations to their factory defaults and 
clears all user properties. 

To restore the factory default settings: 
1. Turn off the supply power.  
2. Disconnect all doors and readers wiring.  
3. Connect Data 0, Data 1, and Tamper inputs to GND (-) in 

both reader 1 and 2 (total of six wires) 
4. Power up the supply power for a few seconds. Wait for the 

"LED3" and "LED4" LEDs to flash alternately. 
5. Turn off the supply power. 
6. Connect the doors and readers wiring again. 
7. In AxTrax AS-525, delete the panel by clearing the Enable 

panel checkbox in the panel screen. Click OK. 
8. Select the Enable panel checkbox in the panel screen and 

click OK. This action causes a full reset of the access control 
panel with the factory settings. 

9. Dial to the appropriate access control panel and click 
password in the modem status screen. Use AxTrax as the 
current password, and change the password to a new 
one. 
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Appendix D. Cross Platform Camera Setup 
This section describes the complete process of adding 
cameras to the AC-525 panels as defined both in AxTrax and 
ViTrax applications as well as emphasize some of the not so 
trivial steps to help ensure proper camera operation. 
This process is essentially a two-step procedure that needs to 
be defined in both applications. 
First, you need to add the installed camera in the ViTrax 
software, only then is it possible to assign the camera to the 
relevant AC-525 panel defined in the AxTrax application.  
 

To add a camera to the system: 
1. Install the AC-525 panel and connect the cameras (see 

AC-525 installation manual) 
2. Add the camera in the ViTrax application by either: 

• Performing a camera search using the Automatically 
discover network devices option. 

• Manually add a camera using the Camera setup 
wizard  Add new device – AC-525. 

3. Configure Motion Detection in the ViTrax application 
(optional – required only if motion detection is used) 
If Motion Detection is required, first define Motion analysis 
via the ViTrax application: 
• In the Camera Setup Wizard click Next until you reach 

the Motion Analysis screen. 
• Select the Use Motion Detector for the Stream Being 

Used checkbox. 
• Click Properties to adjust motion detection properties.  
• In the Source tab, select Software Motion Detection 

Priority, currently only software motion detection is 
available. 

 

 

Note: 
The Motion detection feature consumes a large 
amount of CPU power, resulting in a high overall CPU 
power usage by the application, this may reduce the 
overall number of cameras that can be managed 
by the ViTrax Server application.  

 



Cross Platform Camera Setup 

AS-525 AxTrax Software Installation and User Guide Page 131 
 

4. Add the camera in the AxTrax application:  
• In AxTrax, ensure that the ViTrax Server is configured 

and is "Connected" with AxTrax.  
• In the AxTrax Tree menu, select the relevant AC-525 

Network item.  
• Click the Camera Location icon. On the left, you will see 

the names of the cameras connected with this panel 
as previously defined in ViTrax. On the right dropdown 
list select Panel to add the camera and click OK. A new 
camera icon will appear under the panel icon in Tree 
menu. 

5. Set the camera properties in the AxTrax application:  
• In Tree menu double click the camera item under the 

panel. Camera Properties screen appears.  
• Click Properties to set and define the various camera 

related settings. 
6. Set the camera’s time zone and daylight savings behavior 

in the AxTrax application (Step 1): 
• In the camera properties screen, click the Time tab 
• Select the local Time Zone from the dropdown list. 
• If Daylight Saving Time is now active, select the Enable 

Daylight Saving Time check box. This will advance the 
local time selected by 1 hour.  

• Click Apply or OK 

 

Note: 
Daylight savings is currently not updates 
automatically by Windows. It is therefore the user’s 
responsibility to enable or disable the daylight saving 
time checkbox as necessary.  

7. Set the camera’s time zone and daylight savings behavior 
in the AxTrax application (Step 2): 
• In the Tree menu double click a Panel item and Select 

the Options tab.  
• In the Time Zone section, define the Time zone and 

Daylight Saving Time to match that of the Camera 
properties (in the last step).  

8. Test time synchronization in both application: 
• In tree menu, Select your Network and click the Set 

Time icon, verify that it matches the AxTrax’s Server PC 
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time, select the panel and click Apply (1 or 2 seconds 
difference is acceptable). 

• In the tree menu, double click the Camera icon and 
click Properties. Click the Time tab and verify that it 
matches the AxTrax Server PC time. 

• If the ViTrax Server application and the AxTrax Server 
application are running on different PC’s, ensure that 
both of the PCs are synchronized. It is advised that both 
PCs will be assigned with the same time server.   
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Appendix E. Technical Support 
Asia Pacific, Middle East, Africa 

Rosslare Security Products Headquarters 
905-912 Wing Fat Industrial Bldg,  
12 Wang Tai Road,  
Kowloon Bay Hong Kong  
Tel: +852 2795-5630  
Fax: +852 2795-1508  
E-mail: support.apac@rosslaresecurity.com 

United States and Canada  
1600 Hart Court, Suite 103 
Southlake, TX, USA 76092 
Toll Free: +1-866-632-1101 
Local: +1-817-305-0006 
Fax: +1-817-305-0069 
E-mail: support.na@rosslaresecurity.com 

Europe 
Global Technical Support & Training Center  
HaMelecha 22 
Rosh HaAyin, Israel 48091  
Tel: +972 3 938-6838  
Fax: +972 3 938-6830  
E-mail: support.eu@rosslaresecurity.com 

South America 
Pringles 868, 1640 Martinez 
Buenos Aires, Argentina 
Tel: +54 11 4798-0095 
Fax: +54 11 4798-2228 
E-mail: support.la@rosslaresecurity.com 

 
Web Site: www.rosslaresecurity.com 
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